
 
 
 
 

 
 
 
 
 
 

ภาคผนวก 
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ภาคผนวก  ก 
รายนามผูเช่ียวชาญ 
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รายนามผูเชีย่วชาญที่ใชในการตรวจสอบเครื่องมือ 
 

ผูเชี่ยวชาญดานการออกแบบและพัฒนาบทเรยีน 
1. รองศาสตราจารย.ดร.ประหยัด  จิระวรพงศ        รองศาสตราจารย 

            ภาควิชาเทคโนโลยีและสื่อสารการศึกษา  

            มหาวทิยาลัยนเรศวร 

2. ผูชวยศาสตราจารย.ดร.รุจโรจน  แกวอุไร        ผูชวยศาสตราจารย 

            ภาควิชาเทคโนโลยีและสื่อสารการศึกษา  

            มหาวทิยาลัยนเรศวร 

3. ผูชวยศาสตราจารย.ดร.ทิพรัตน  สิทธวิงศ                ผูชวยศาสตราจารย 

            ภาควิชาเทคโนโลยีและสื่อสารการศึกษา  

            มหาวทิยาลัยนเรศวร 

 
ผูเชี่ยวชาญดานการวิจยั 
1. รองศาสตราจารย.ดร.วารีรัตน  แกวอุไร                รองศาสตราจารย 

            ภาควิชาการศึกษา  

            มหาวทิยาลัยนเรศวร 

2.  ดร.อังคนา  ออนธาน ี                  อาจารย 

            ภาควิชาการศึกษา  

            มหาวทิยาลัยนเรศวร 

3.  ดร.เอ้ือมพร  หลินเจริญ                 อาจารย 

            ภาควิชาการศึกษา  

            มหาวทิยาลัยนเรศวร 
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ผูเชี่ยวชาญดานหลกัสูตรและเนื้อหา 
1.  นางชาลินี  พรมแสง           ครูชํานาญการพิเศษ 

       โรงเรียนหลมสักวิทยาคม 

                  อําเภอหลมสัก  จังหวดัเพชรบูรณ  

2.  นายเอกรินทร  ทรัพยอนนัต                 ครูชํานาญการพิเศษ   

       โรงเรียนหลมเกาพทิยาคม     

       อําเภอหลมเกา  จงัหวดัเพชรบูรณ 

3.  นางมยุรี  บุญนิล                         ครูชํานาญการพิเศษ   

       โรงเรียนบานปาแกเครือ       

        อําเภอหลมสัก  จังหวดัเพชรบูรณ 
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ภาคผนวก  ข 
 

สําเนาหนังสือถึงผูเช่ียวชาญเพื่อตรวจแกไขเครื่องมือ  และผูอํานวยการ
โรงเรียนต้ิววิทยาคม  เพื่อขอนุญาตเก็บขอมูล 
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บันทึกขอความ 
 

สวนราชการ    บัณฑิตวทิยาลัย  งานบริการการศึกษา  โทร. 2443, 2444 

ที่ ศธ 0527.02.01/    วันที่  29  เดือน  มิถนุายน  พ.ศ. 2553 

เรื่อง   ขอความอนุเคราะหตรวจแกไขเคร่ืองมือที่ใชในการศึกษาคนควาดวยตนเอง 

 
เรียน   

  ดวย  นางศุภลักษณ  ขวัญแสน  รหัสประจําตัว  51091625  นิสิตปริญญาโท  

สาขาวิชาเทคโนโลยีและส่ือสารการศึกษา  แขนงคอมพิวเตอรศึกษา  สังกัดบัณฑิตวิทยาลัย  

มหาวิทยาลัยนเรศวร  ไดทําการศึกษาคนควาดวยตนเอง  เร่ือง  “การพัฒนาบทเรียนบนเครือขาย  

ตามรูปแบบการเรียนรูแบบรวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ัน

มัธยมศึกษาปที่  4”  ตามหลักสูตรปริญญามหาบัณฑิต  โดยมีผูชวยศาสตราจารย  ดร.ภาสกร  

เรืองรอง  เปนอาจารยที่ปรึกษาการคนควาดวยตนเอง 

   ในการศึกษาคนควาเกี่ยวกับเร่ืองนี้  บัณฑิตวิทยาลัย  มหาวิทยาลัยนเรศวร  

พิจารณาแลวเห็นวาทานเปนผูที่มีความรูเชี่ยวชาญในเร่ืองนี้เปนอยางดียิ่ง  จึงใครขอเรียนเชิญทาน

เปนผูเชี่ยวชาญพิจารณาตรวจแกไขเคร่ืองมือที่ใชในการศึกษาคนควาดวยตนเอง  ดังแนบมาพรอม

นี้  บัณฑิตวิทยาลัย  มหาวิทยาลัยนเรศวรหวังเปนอยางยิ่งวาคงจะไดรับความอนุเคราะหจากทาน

ดวยดี  และขอขอบคุณอยางสูงมา  ณ  โอกาสนี้ 
 

   จึงเรียนมาเพือ่โปรดพิจารณาใหความอนุเคราะห 

 

 

( ผูชวยศาสตราจารย  ดร.คนึงนิจ  ภูพัฒนวิบูลย ) 

         คณบดีบัณฑิตวทิยาลัย 
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ที่ ศธ 0527.02.01/                                  บัณฑิตวิทยาลัย  มหาวิทยาลัยนเรศวร   

               อาํเภอเมือง  จังหวัดพิษณุโลก  65000 

 

            29  มิถุนายน  2553 

 

เรื่อง  ขอความอนุเคราะหตรวจแกไขเคร่ืองมือท่ีใชในการศึกษาคนควาดวยตนเอง 

เรียน   

สิ่งที่สงมาดวย  1.  โครงรางการศึกษาคนควาดวยตนเอง  จํานวน  1  ฉบบั 

             2.  เคร่ืองมือท่ีใชในการศึกษาคนควาดวยตนเอง  จํานวน  1  ฉบับ 

  ดวย  นางศุภลักษณ  ขวัญแสน  รหัสประจําตัว  51091625  นิสิตปริญญาโท  

สาขาวิชาเทคโนโลยีและสื่อสารการศึกษา   แขนงคอมพิวเตอร ศึกษา   สังกัดบัณฑิตวิทยาลัย  

มหาวิทยาลัยนเรศวร  ไดทําการศึกษาคนควาดวยตนเอง  เร่ือง  “การพัฒนาบทเรียนบนเครือขายตาม
รูปแบบการเรียนรูแบบรวมมือเทคนิค  TGT  เรื่อง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนชั้น
มัธยมศึกษาปที่  4”  ตามหลักสูตรปริญญามหาบัณฑิต  โดยมีผูชวยศาสตราจารย  ดร.ภาสกร  เรืองรอง  

เปนอาจารยท่ีปรึกษาการคนควาดวยตนเอง 

   ในการศึกษาคนควาเก่ียวกับเร่ืองน้ี  บัณฑิตวิทยาลัย  มหาวิทยาลัยนเรศวร  พิจารณา

แลวเห็นวาทานเปนผูท่ีมีความรูเชี่ยวชาญในเร่ืองน้ีเปนอยางดียิ่ง  จึงใครขอเรียนเชิญทานเปนผูเชี่ยวชาญ

พิจารณาตรวจแกไขเคร่ืองมือท่ีใชในการศึกษาคนควาดวยตนเอง  ดังแนบมาพรอมน้ี  บัณฑิตวิทยาลัย  

มหาวิทยาลัยนเรศวรหวังเปนอยางย่ิงวาคงจะไดรับความอนุเคราะหจากทานดวยดี  และขอขอบคุณอยาง

สูงมา  ณ  โอกาสนี้ 

 

   จึงเรียนมาเพื่อโปรดพิจารณาใหความอนุเคราะห 

            ขอแสดงความนับถอื 

 

(ผูชวยศาสตราจารย  ดร.คนึงนิจ  ภูพฒันวบิลูย) 

      คณบดีบัณฑิตวิทยาลัย  มหาวิทยาลัยนเรศวร 
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ที่ ศธ 0527.02.01/4326                                บัณฑิตวิทยาลัย  มหาวิทยาลัยนเรศวร   

                อําเภอเมอืง  จังหวัดพิษณุโลก  65000 

 

            4  ตุลาคม  2553 

 

เรื่อง  ขอความรวมมือเก็บขอมูลเพื่อการศึกษาคนควาดวยตนเอง 

เรียน  ผูอํานวยการโรงเรียนต้ิววิทยาคม 

สิ่งที่สงมาดวย  1.  เคร่ืองมือท่ีใชในการเก็บขอมฃู  จํานวน  1  ฉบับ 

  ดวย  นางศุภลักษณ  ขวัญแสน  รหัสประจําตัว  51091625  นิสิตปริญญาโท  

สาขาวิชาเทคโนโลยีและสื่อสารการศึกษา   แขนงคอมพิวเตอร ศึกษา   สังกัดบัณฑิตวิทยาลัย  

มหาวิทยาลัยนเรศวร  ไดทําการศึกษาคนควาดวยตนเอง  เร่ือง  “การพัฒนาบทเรียนบนเครือขายตาม
รูปแบบการเรียนรูแบบรวมมือเทคนิค  TGT  เรื่อง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนชั้น
มัธยมศึกษาปที่  4”  ตามหลักสูตรปริญญามหาบัณฑิต  โดยมีผูชวยศาสตราจารย  ดร.ภาสกร  เรืองรอง  

เปนอาจารยท่ีปรึกษาการคนควาดวยตนเอง 

   ในการศึกษาคนควาเร่ืองน้ี  จําเปนตองเก็บขอมูลจากหนวยงานของทาน  บัณฑิต

วิทยาลัย  จึงใครขอความอนุเคราะหจากทาน  โปรดอนุญาตใหนิสิตดําเนินการเก็บรวบรวมขอมูลใน

การศึกษาคนควาดวยตนเอง  ซึ่งจะเปนประโยชนทางวิชาการตอไป  บัณฑิตวิทยาลัย  มหาวิทยาลัย

นเรศวร  หวังเปนอยางย่ิงวาคงจะไดรับความอนุเคราะหจากทานดวยดี  และขอขอบคุณอยางสูงมา  ณ  

โอกาสนี้ 

 

   จึงเรียนมาเพื่อโปรดพิจารณาใหความอนุเคราะห 

            ขอแสดงความนับถอื 

 

 

     (ผูชวยศาสตราจารย  ดร.ปาจรีย  ทองสนิท) 

     รองคณบดีฝายวิชาการ  รักษาราชการแทน 

        คณบดีบัณฑิตวิทยาลัย  มหาวิทยาลัยนเรศวร 
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ภาคผนวก  ค 
 

เครื่องมือที่ใชในการศึกษาคนควา 
 

1.  แบบประเมินความสอดคลองดานสาระการเรียนรูกับผลการเรียนรู 

2.  แบบประเมินความสอดคลองดานผลการเรียนรูกับแบบทดสอบ 

3.  แบบประเมินคุณภาพของบทเรียนบนเครือขายตามรูปแบบการเรียนแบบรวมมือ

เทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนระดับชั้นมัธยมศึกษาปที่  4   

4.  แบบสอบถามความคิดเห็นของนักเรียนช้ันมัธยมศึกษาปที่  4  ที่มีตอวิธีสอนดวย

บทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบรวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  

สําหรับนักเรียนระดับชั้นมัธยมศึกษาปที่  4   
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แบบประเมินความสอดคลองระหวางสาระการเรียนรูกับผลการเรียนรู 
สําหรับผูเช่ียวชาญ 

 

หัวขอวิจัย  เร่ือง  การพัฒนาบทเรียนบนเครือขายตามรูปแบบการเรียนแบบรวมมือเทคนิค  TGT  

เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนระดับชั้นมัธยมศึกษาปที่  4 

 
ผูวิจัย 

1. นางศุภลักษณ  ขวัญแสน 

 
วัตถุประสงคงานวจิัย 

1.  เพื่อพัฒนาและหาประสิทธิภาพของบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบ

รวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษาปที่  4 

2.  เพื่อหาความกาวหนาทางการเรียนของผูเรียนดวยบทเรียนบนเครือขายตามรูปแบบ

การเรียนรูแบบรวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษา

ปที่  4 

3.  เพื่อศึกษาความคิดเห็นของผูเรียนที่มีตอการใชบทเรียนบนเครือขายตามรูปแบบการ

เรียนรูแบบรวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษา     

ปที่  4 

 
คําชี้แจง 

1.  แบบประเมินความสอดคลองประกอบไปดวยสาระการเรียนรูกับผลการเรียนรู  เร่ือง

คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนระดับชั้นมัธยมศึกษาปที่  4  ประกอบไปดวย  7  หนวย  

และ  16  ผลการเรียนรู 

2.  ผลการเรียนรูที่คาดหวัง  ทั้ง  3  ดาน  มีความหมาย  ดังนี้ 

        K  (Knowledge) คือ  ดานความรู     

        P  (Process) คือ  ดานทักษะกระบวนการ 

        A  (Attitude) คือ  ดานคุณธรรม/จริยธรรม/คุณลักษณะอันพึงประสงค 
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 3.  โปรดพิจารณาวาสาระสําคัญแตละขอ  สามารถวัดไดตรงตามผลการเรียนรูที่

ระบุไวหรือไม  แลวเขียนผลการพิจารณาของทานโดยกาเคร่ืองหมาย       ลงในชองคะแนนการ

พิจารณา  ตามความคิดเห็นของทานดังนี้ 

       +1  ถาแนใจวาสาระสําคัญมีความสอดคลองตามผลการเรียนรู 

       0    ถาไมแนใจวาสาระสําคัญมีความสอดคลองตามผลการเรียนรู 

       -1  ถาแนใจวาสาระสําคัญไมสอดคลองตามผลการเรียนรู 

 4.  หากทานมีขอเสนอแนะกรุณาเพิ่มเติมลงในชอง  ขอเสนอแนะ 
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ผลการ
เรียนรู 

IOC 
ขอ 

เสนอแนะ สาระการเรียนรู ผลการเรียนรู 
K P A -1 0 +1  

หนวยที่  1  รูจักกับโปรแกรม Flash        

1. คุณลักษณะของ

โปรแกรม Flash 

2. การเรียกใชโปรแกรม 

Flash 

3. สวนประกอบของ

โปรแกรม Flash 

4. เคร่ืองมือทีใ่ชในการ

สรางสรรคผลงานของ

โปรแกรม Flash 

1. อธิบายลักษณะโครงสราง

และสวนประกอบของ

โปรแกรม Flash  ได 

2. สามารถใชเคร่ืองมือ , 

องคประกอบตาง ๆ ของ

โปรแกรม Flash ในการสราง

ภาพเคลื่อนไหวข้ันพืน้ฐานได 

 

/ 

 

 

/ 

 

 

 

 

 

 

 

/ 

 

 

 

/ 

 

    

หนวยที่ 2 การใชเคร่ืองมือในการวาดภาพและการใชสี        

1. เคร่ืองมือตาง ๆ ในกลอง

เคร่ืองมือ 

2. การใชเคร่ืองมือวาดภาพ

และกําหนดสี 

 

1. อธิบายคุณสมบัติของ

เคร่ืองมือแตละชนิดในกลอง

เคร่ืองมือได 

2. สามารถใชเคร่ืองมือ 

แตละชนิดไดอยางถูกวิธ ีและ

เหมาะสมกับการทาํงาน 

/ 

 

 

/ 

 

 

 

/ 

 

 

 

/ 

    

หนวยที่ 3 การสรางภาพเคล่ือนไหวแบบ Frame by Frame        

1. ความรูพืน้ฐานของการ

สรางภาพเคลื่อนไหว 

2. การกําหนดและควบคุม

ลําดับการทํางานของการ

เคล่ือนไหวดวย Scene  

3. ความหมาย  ข้ันตอน 

และเทคนิคการสราง

ภาพเคลื่อนไหว  

แบบ Frame by Frame 

1. อธิบายหลักการทํางาน

ของการเคล่ือนไหวและ

ลักษณะของการเคล่ือนไหว

แบบ Frame by Frame ได 

2. สามารถกาํหนดและ

ควบคุมลําดับการทาํงานของ

การเคลื่อนไหวดวย Scene 

ได 

 

/ 

 

 

 

/ 

 

 

 

 

 

 

 

 

/ 

 

 

 

 

 

 

 

 

/ 
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ผลการ
เรียนรู 

IOC 
ขอ 

เสนอแนะ สาระการเรียนรู ผลการเรียนรู 
K P A -1 0 +1  

3. สามารถสรางงานท่ีม ี

การเคลื่อนไหวแบบ 

Frame by Frame ดวย

โปรแกรม Flash ได 

/ / 

 

/ 

หนวยที่ 4 การสรางภาพเคล่ือนไหว แบบ Motion Tween        

1. การสรางภาพเคลื่อนไหว

แบบ  Tween 

2. การสรางภาพเคลื่อนไหว

แบบ  Motion Tween 

1. อธิบายหลักการสราง

ภาพเคลื่อนไหวแบบ  

Motion Tween ได 

2. สามารถสราง

ภาพเคลื่อนไหวแบบ  

Motion Tween ดวย

โปรแกรม Flash ได 

/ 

 

 

/ 

 

 

 

 

 

 

/ 

 

 

 

/ 

    

หนวยที่ 5 การสรางภาพเคล่ือนไหว แบบ Motion Guide         

1. การสรางภาพเคลื่อนไหว

แบบ Guide Motion  

2. เทคนิคในการสราง

ภาพเคลื่อนไหว แบบตาง ๆ 

1. อธิบายเกีย่วกับข้ันตอน

และหลักการในการสราง

ภาพเคลื่อนไหวแบบ 

Guide Motion ที่ไดกําหนด

เอาไวไดอยางถูกตอง 

2. สามารถสราง

ภาพเคลื่อนไหวแบบ  

Motion Guide ไดถูกตอง

และสวยงาม 

/ 

 

 

 

 

/ 

 

 

 

 

 

 

 

 

/ 

 

 

 

 

 

 

 

 

/ 

 

    

หนวยที่ 6 การใชงาน Layer Mask        

1. การทํางานของ  

Layer Mask 

2. การสราง Layer Mask 

3. การนําLayer Mask ไป

1. สามารถสรางงาน

ภาพเคลื่อนไหวแบบ  

Layer Mask ได 

 

/ 
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ผลการ
เรียนรู 

IOC 
ขอ 

เสนอแนะ สาระการเรียนรู ผลการเรียนรู 
K P A -1 0 +1  

ประยุกตในการนําเสนอ

ผลงาน การสราง

ภาพเคลื่อนไหวแบบตาง ๆ 

2. สามารถอธบิายวธิีการ

สรางและข้ันตอนทาํ  

Layer Mask ได 

3. สามารถนํา Layer Mask 

ไปประยุกตสรางงาน

ภาพเคลื่อนไหวแบบตาง ๆ 

ได 

/ 

 

 

/ 

/ 

 

 

/ 

/ 

 

 

/ 

หนวยที่ 7 การสรางตัวอักษรแบบคาราโอเกะ        

1. การเคลื่อนไหวของ

ตัวอักษรแบบคาราโอเกะ 

2. หลักการทํางานของ

ตัวอักษรแบบคาราโอเกะ 

3. การสรางการเคลื่อนไหว

ของตัวอักษรแบบ 

คาราโอเกะ 

1. อธิบายลักษณะและ

หลักการทาํงานของตัวอักษร

แบบคาราโอเกะได 

2. สามารถสรางการ

เคล่ือนไหวของตัวอักษรแบบ

คาราโอเกะ และนําไป

ประยุกตใชกับชิ้นงานของ

ตนเองได 

/ 

 

 

/ 

 

 

 

 

 

 

 

/ 

 

 

 

 

 

 

 

/ 

    

 

ความคิดเหน็อ่ืน ๆ 

............................................................................................................................................... 

............................................................................................................................................... 

............................................................................................................................................... 

 

 

    ลงช่ือ................................................ 

           (...............................................) 

                 ผูประเมิน 

     ........../............../.............. 
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แบบประเมินความสอดคลองระหวางผลการเรียนรูและแบบทดสอบ 
สําหรับผูเช่ียวชาญ 

 

หัวขอวิจัย  เร่ือง  การพฒันาบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบรวมมอืเทคนิค  TGT  

เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนกัเรียนระดับชัน้มธัยมศึกษาปที ่ 4 

 
ผูวิจัย 

1. นางศุภลักษณ  ขวัญแสน 

 
วัตถุประสงคงานวจิัย 

1.  เพื่อพฒันาและหาประสิทธิภาพของบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบ

รวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมลัติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษาปที่  4 

2.  เพื่อหาความกาวหนาทางการเรียนของผูเรียนดวยบทเรียนบนเครือขายตามรูปแบบ

การเรียนรูแบบรวมมือเทคนคิ  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษา 

ปที่  4 

3.  เพื่อศึกษาความคิดเหน็ของผูเรียนที่มีตอการใชบทเรียนบนเครือขายตามรูปแบบการ

เรียนรูแบบรวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษา 

ปที่  4 

 
คําชี้แจง 

1.  แบบประเมินความสอดคลองประกอบไปดวยขอสอบที่ใชวัดผลตามผลการเรียนรูและ

สาระการเรียนรู  วิชา  คอมพวิเตอรมัลติมีเดีย  สําหรับนกัเรียนระดับชัน้มัธยมศึกษาปที่  4  จํานวน  

100  ขอ 

2.  โปรดพิจารณาวาขอสอบแตละขอ  สามารถวัดไดตรงตามผลการเรียนรูที่ระบุไว

หรือไม  แลวเขียนผลการพิจารณาของทานโดยกาเคร่ืองหมาย         ลงในชองคะแนนการพิจารณา  

ตามความคิดเห็นของทานดังนี้ 

     +1  ถาแนใจวาขอสอบมคีวามสอดคลองตามผลการเรียนรู 

     0    ถาไมแนใจวาขอสอบมีความสอดคลองตามผลการเรียนรู 

     -1   ถาแนใจวาขอสอบไมความสอดคลองตามผลการเรียนรู 

3.  หากทานมขีอเสนอแนะกรุณาเพิ่มเติมลงในชอง  ขอเสนอแนะ 



 105 

IOC 
ผลการเรียนรู ขอสอบ 

-1 0 +1 
ขอ 

เสนอแนะ 

หนวยที่ 1 รูจักกับ

โปรแกรม Flash  

1. อธิบายลักษณะ

โครงสรางและ

สวนประกอบของ

โปรแกรม Flash  ได 

2. สามารถใช

เคร่ืองมือ , 

องคประกอบตาง ๆ 

ของโปรแกรม Flash 

ในการสราง

ภาพเคลื่อนไหว 

ข้ันพืน้ฐานได 

 

1. โปรแกรม Flash  เปนผลิตภัณฑของ

บริษัทใด 

    ก. Adobe                 

    ข. Microsoft 

    ค. AMD                    

    ง. Macromedia 

 

จากภาพใชตอบขอ  2 – 3  

 
2. หมายเลข  1  หมายถึงอะไร 

    ก. การสรางงานใหมจากแบบฟอรมที่

โปรแกรมกําหนดมาให 

    ข. การแสดงไฟลงานที่เคยเปดใชงาน

มาแลว 

    ค. ประเภทรูปแบบในการสรางงาน 

    ง. การเขียน Script และ Flash Project  

3. หมายเลข  3  หมายถึงอะไร 

    ก. การสรางงานใหมจากแบบฟอรมที่

โปรแกรมกําหนดมาให 

    ข. การแสดงไฟลงานที่เคยเปดใชงาน

มาแลว 

    ค. ประเภทรูปแบบในการสรางงาน 

    ง.  การเขียน Script และ Flash 

Project  
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IOC 
ผลการเรียนรู ขอสอบ 

-1 0 +1 
ขอ 

เสนอแนะ 

4. เมนูในขอใด  เปนสวนสําคัญที่ชวย 

ในการทําภาพเคล่ือนไหว 

    ก. File 

    ข. Edit 

    ค. View  

    ง. Insert 

5. สวนบริเวณพื้นที่สีเทา  สําหรับจัดวาง

วัตถุพกัไวเพื่อเตรียมที่จะนําไปใชงานบน

Stage  เรียกวา อะไร 

    ก. Document 

    ข. Flash  Document 

    ค. Work 

    ง. Work  Area 

6. ขอใด  หมายถึง  การทาํงานของ  

Timeline   

    ก. บรรจุภาพและเสียงที่จดัวางบน  

stage 

    ข. ยอขยายสวนพื้นที ่

    ค. กํากับเวลาในการแสดง

ภาพเคลื่อนไหว 

    ง. จัดวางวตัถุ 

7. คําส่ังในขอใดใช  เปด/ปด  Timeliine 

    ก. View > Timeline 

    ข. Insert > Timeline 

    ค. Modify > Timeline 

    ง. Window> Timeline  

 

 



 107 

IOC 
ผลการเรียนรู ขอสอบ 

-1 0 +1 
ขอ 

เสนอแนะ 

8. ขอใด  ไมอยู  ในสวนประกอบของ

หนาจอ  Timeline 

    ก. Layer 

    ข. Playhead 

    ค. Stage 

    ง. Frame 

9. Frame  ทําหนาที่อะไร 

    ก. บรรจุภาพและเสียงที่จดัวางบน  

stage 

    ข. ยอขยายสวนพื้นที ่

    ค. กํากับเวลาในการแสดง

ภาพเคลื่อนไหว 

    ง. จัดวางวตัถุ 

10. Playhead  มีลักษณะอยางไร 

    ก. เสนสีขาว 

    ข. เสนสีดํา 

    ค. เสนสีแดง 

    ง. เสนสีเขียว 

11. การจัดเรียงเร่ืองราว  ตองกระทาํตรง

สวนใด  เพื่อแสดงผลเปน  Flash  Movie 

    ก. Stage 

    ข. Word  Area 

    ค. Playhead 

    ง. Frame 

12. เร่ืองราวทีจ่ัดเรียง  จะถกูแสดงเมื่อ 

มีการผานของเคร่ืองมือใด 

    ก. Stage 

    ข. Timeline 
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IOC 
ผลการเรียนรู ขอสอบ 

-1 0 +1 
ขอ 

เสนอแนะ 

    ค. Playhead 

    ง. Frame 

13. สวนสําคัญในการสราง

ภาพเคลื่อนไหว  เปรียบเสมอืนการนํา

แผนหลาย ๆ แผนมาวางซอนกนั  

หมายถงึ  ขอใด 

    ก. Frame 

    ข. KeyFrame 

    ค. Layer 

    ง. Timeline 

14. คําส่ังที่ใชในการเปด/ปด   

แถบเคร่ืองมือ  คือขอใด 

    ก. Window > Toolbar 

    ข. Window > Toolbar > Main 

    ค. View > Toolbar  

    ง. View > Toolbar > Main 

15. ไฟลเอกสารของ  Flash   เรียกวา

อะไร 

    ก. File 

    ข. Movie 

    ค. File  animation 

    ง. Entertainment  
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16. หมายเลข  1  หมายถึงกลุมเคร่ืองมือ

ที่ใชในดานใด 

    ก. กลุมสีเสนและสีพืน้ 

    ข. กลุม Option เพิ่มเติม 

    ค. กลุมการวาดและตกแตง   

    ง. กลุมเลือก  Select  

17. หมายเลข  2  หมายถึงกลุมเคร่ืองมือ

ที่ใชในดานใด 

    ก. กลุมสีเสนและสีพืน้ 

    ข. กลุม Option เพิ่มเติม 
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    ค. กลุมการวาดและตกแตง             

    ง. กลุมเลือก  Select  

18. หมายเลข  4  หมายถึงกลุมเคร่ืองมือ

ที่ใชในดานใด 

    ก. กลุมสีเสนและสีพืน้ 

    ข. กลุม Option เพิ่มเติม 

    ค. กลุมการวาดและตกแตง             

    ง. กลุมเลือก  Select  

19. การลบเสนไกดทัง้หมด  ใหเลือกคําส่ัง

ใด 

    ก. View > Guides > Show Guides 

    ข. View > Guides > Lock Guides     

    ค. View > Guides > Clear Guides 

    ง. View > Guides > Move Guides 

20. การลบเสนไกดทีละเสน  ตองทํา

อยางไร 

    ก. ใชคําส่ัง  Clear 

    ข. ใชคําส่ัง  Delete 

    ค. ใชคําส่ัง  Cut 

    ง. ใหคลิกลากเสนไกดออกนอกเวท ี

21. ขอใด ไมใช ข้ันตอนการสราง

ภาพเคลื่อนไหว  

    ก. การวางโครงเร่ืองชิ้นงาน 

    ข. การจัดเตรียมองคประกอบ

ชิ้นงาน       

    ค. การเขียนช้ินงาน  

    ง. การแปลงไฟลเปนช้ินงานสําหรับการ

เผยแพร 
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22. การเขียน   storyboard   จัดอยูใน

ข้ันตอนใดของการสรางมูฟวี ่

    ก. การวางโครงเร่ืองชิ้นงาน 

    ข. การจัดเตรียมองคประกอบชิ้นงาน   

    ค. การเขียนช้ินงาน  

    ค. การแปลงไฟเปนช้ินงานสําหรับ 

การเผยแพร  

23. การแปลงไฟลชิ้นงานสําหรับ 

การเผยแพรบนระบบเครือขาย เราเรียกวา

อะไร 

    ก. Animation              

    ข. Photograph 

    ค. Publish                  

    ง. Account  

24. ขอใด  ไมใช  รูปแบบการแปลงไฟล

เปนช้ินงานสําหรับการเผยแพร 

    ก. Flash  Document 

    ข. HTML  Document 

    ค. Flash  Movie 

    ง. HTML  Movie 

25. ขอใด  ไมใช  ประโยชนของโปรแกรม  

Flash 

    ก. ทําเว็บไซต 

    ข. คํานวณสูตร 

    ค. ทาํการตูน   

    ง. นําเสนอผลงาน 
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หนวยที่ 2 การใช

เคร่ืองมือในการวาด

ภาพและการใชสี 

1. อธิบายคุณสมบัติ

ของเคร่ืองมือแตละ

ชนิดในกลอง

เคร่ืองมือได 

2. สามารถใช

เคร่ืองมือแตละชนิด

ไดอยางถกูวิธ ีและ

เหมาะสมกับการ

ทํางาน 

26. เคร่ืองมือใดที่ใชในการระบายสีใหกับ

ภาพ คลายพูกัน 

    ก. Text Tool 

    ข. Brush Tool 

    ค. Eye Dropper Tool 

    ง. Fill Transform Tool 

27. Oval Tool เปนเคร่ืองมอืวาดรูป 

ลักษณะใด 

    ก. วาดส่ีเหล่ียม  

    ข. วงรีหรือวงกลม 

    ค. รูปดาว   

    ง. รูปหลายเหล่ียม 

28. การใชเคร่ืองมือวาดรูปวงกลม แตจะ

เปนรูปวงรี ถาตองการใหเปนวงกลมจะ

แกไขอยางไร 

    ก. ขณะวาดใหกดแปน Ctrl คางไวดวย 

   ข. ขณะวาดใหกดแปน Shift คางไวดวย 

    ค. ขณะวาดใหกดแปน F12 คางไวดวย 

    ง. ขณะวาดใหกดแปน Alt คางไวดวย 

29. เมนูใดที่ใชคําส่ังเรียก Panel  สี 

    ก. Modify > Color 

    ข. Edit > Color 

    ค. Insert > Color  

    ง. Window > Color Mixer 
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30. Short Cut Key ใดที่ใชสําหรับ เลือก

วัตถุทัง้หมด 

    ก. Ctrl+Alt+Del  

    ข. Ctrl+Y 

    ค. Ctrl+A   

    ง. Ctrl+Z 

31. Stoke  มลัีกษณะเชนไร 

    ก. วงกลม  

    ข. วงรี 

    ค. ลายเสน 

    ง. ส่ีเหล่ียม 

32. การวาด  Merge  Drawing  

หมายความวาอยางไร 

    ก. รูปทรงทีไ่ดจากการวาดเปนอิสระ 

ตอกัน 

    ข. รูปทรงทีไ่ดจากการวาดแยกไดหลาย

สวน 

    ค. รูปทรงทีว่าดมีผลกระทบตอรูปทรง

อ่ืน 

    ง. รูปทรงทีว่าดไมมีการเปล่ียนแปลง 

33. การกาํหนดคุณสมบัติสีพื้นและสีเสน  

ขอใดไมสามารถกระทาํได 

    ก. ความหนา 

    ข. ความละเอียด 

    ค. รูปแบบเสน 

    ง. รูปแบบลายเสน 
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จากภาพใชตอบขอ  34 – 37 

 
 

34. หมายเลข  6  มีหนาที่อะไร  

    ก. ใสสีใหกบัเสน 

    ข. ใสสีใหกบัพื้นวัตถ ุ

    ค. ลบสีออกจากเสน 

    ง. ลบสีออกจากพืน้วัตถ ุ 

35. หมายเลข  7  มีหนาที่อะไร 

    ก. วาดวัตถ ุ

    ข. ลบวัตถ ุ

    ค. ใสสีใหกบัวัตถ ุ  

    ง. เลือกวัตถุตามอิสระ  
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36. หมายเลข 8  มีหนาที่อะไร  

    ก. แทรกรูปภาพ 

    ข. แทรกวัตถุตาง ๆ ที่ตองการ 

    ค. พิมพขอความ 

    ง. ลบวัตถ ุ

37. หมายเลข 10  มีหนาที่อะไร 

    ก. แทรกรูปภาพ 

    ข. แทรกวัตถุตาง ๆ ที่ตองการ 

    ค. พิมพขอความ 

    ง. ลบวัตถ ุ 

38. ถาตองการทําเสนตรง ใหเปนเสนมมุ

แหลม ตองกดแปนพิมพขอใดดวย  

ก. Ctrl  

ข. Alt  

ค. Shift  

ง. Backspace  

39. การวาดรูปทรงกลมหรือรูปส่ีเหล่ียม

จัตุรัส ตองกดแปนพิมพในขอใดดวย  

ก. Alt  

ข. Shift  

ค. Ctrl  

ง. Spacebar  

หนวยที่  3 การสราง

ภาพเคลื่อนไหวแบบ 

Frame by Frame 

1. อธิบายหลักการ

ทํางานของการ

เคล่ือนไหวและ

40. Frame  Rate  คือ  การกําหนดคา

อะไร 

    ก. ความเร็วของ  Movie 

    ข. ความเร็วของ  Width 

    ค. ชื่อของเอกสาร 

    ง. รายละเอียด 
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ลักษณะของการ

เคล่ือนไหวแบบเฟรม

ตอเฟรม ได 

2. สามารถกําหนด

และควบคุมลําดับการ

ทํางานของการ

เคล่ือนไหวดวยฉากได 

3. สามารถสรางงานที่

มีการเคล่ือนไหวแบบ

เฟรมตอเฟรมดวย

โปรแกรม Flash ได 

41. Playhead  จะตองสัมพนัธกับอะไร 

    ก. เวลา 

    ข. ความเร็ว 

    ค. Animation 

    ง. รายละเอียด 

42. ขอใด  เปนการต้ังคาหนวยของ 

ไมบรรทัด 

    ก. Width 

    ข. Pixel 

    ค. Stage 

    ง. Movie 

43. คียลัดในขอใดใชในการเพิ่ม  Scene 

    ก. Shift + F1 

    ข. Shift + F2 

    ค. Shift + F3 

    ง. Shift + F4 

44. เคร่ืองมือในขอใดเปนตัววิ่งผานแตละ  

Frame  ใน  Timeline 

    ก. Scene 

    ข. Playhead 

    ค. Frame 

    ง. Keyframe 

45. Frame ที่มีสีเทาและมีจดุวงกลมสีดํา

อยูขางในเฟรม เรียกวาอะไร  

ก. Blank Frame  

ข. Frame  

ค. KeyFrame  

ง. Blank KeyFrame  
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46. ขอใดเปนคําส่ังใชสําหรับลบเฟรม  

ก. Insert Frame  

ข. Insert KeyFrame  

ค. Insert Blank KeyFrame  

ง. Remove Frame  

47. Frame ที่มีสีเขียว เกิดจากการสราง

การเคลื่อนไหวแบบใด  

ก. Tween Shape  

ข. Tween Motioin  

ค. Frame By Frame  

ง. Remove Frame 

48. การกาํหนด Frame Rate 12 fps 

หมายถงึขอใด 

    ก. การกําหนดความเร็วในการแสดงผล 

    ข. การกาํหนดอัตราความเร็วของ

ภาพเคลื่อนไหว 12 เฟรม ตอ 1 วินาท ี

    ค. อัตราความเร็วของโปรแกรม  

    ง. ความเร็วในการทํางานของโปรแกรม 

49.  Scene   เรียกอีกอยางวาอะไร 

    ก. ฉาก 

    ข. พืน้หลัง 

    ค. background 

    ง. Movie  

50. Frame  คืออะไร 

    ก. จุดหรือตําแหนงวาง  Layer 

    ข. จุดหรือตําแหนงที่วางช้ินงาน 

หรือวัตถ ุ

    ค. ระยะเวลาของการแสดงใน  Layer 
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    ง. ระยะเวลาการแสดงของช้ินงาน 

หรือวัตถ ุ 

51. Time Line  คืออะไร 

    ก. จุดหรือตําแหนงวาง  Layer 

    ข. จุดหรือตําแหนงที่วางช้ินงาน 

หรือวัตถ ุ

    ค. ระยะเวลาของการแสดงใน  Layer 

    ง. ระยะเวลาการแสดงของช้ินงาน 

หรือวัตถ ุ 

52. ถาตองการแทรก KeyFrame  ตองกด

ปุมใด 

    ก. F1 

    ข. F2 

    ค. F6  

    ง. F12  

53. ถาตองการดูผลการแสดง

ของ  Movie  ตองกดปุมใด 

    ก. Ctrl  +   Enter 

    ข. Ctrl  +   Shift 

    ค. Shift  +   Enter   

    ง. Alt   +  Shift  

54. หากตองการนําช้ินงานของ  Flash  

 ไปแสดงบนเวบ็บราวเซอร  ตองเปน

นามสกุลใด   

    ก. .fla 

    ข. .exe       

    ค. .php 

    ง. .swf  
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55. สัญลักษณของโปรแกรม  Flash  คือ

ขอใด 

    ก.  

    ข.  

    ค.  

    ง.  

56. ไฟลที่ผานการ  Publish  แลวจะมี

สัญลักษณแบบใด 

    ก.  

    ข.  

    ค.  

    ง.  

หนวยที่  4 การสราง

ภาพเคลื่อนไหว แบบ 

Motion Tween 

1. อธิบายหลักการ

สรางภาพเคลื่อนไหว

แบบเปล่ียนแปลง

ตําแหนงได 

2. สามารถสราง

ภาพเคลื่อนไหวแบบ

เปล่ียนแปลงตําแหนง

ดวยโปรแกรม Flash 

57. Motion  คือ การเคลื่อนที่แบบใด     

    ก. ไมเคล่ือนไหว 

    ข. เคล่ือนไหวเปล่ียนแปลงรูปราง 

    ค. เคล่ือนทีช่าแลวเร็วข้ึน 

    ง. เคล่ือนทีแ่บบยายสถานที่ไมเปล่ียน

รูปราง 

58. Shape  คือ  การเคล่ือนที่แบบใด     

    ก. เคล่ือนไหวเปล่ียนแปลงรูปราง 

    ข. ไมเคล่ือนไหว 

    ค. เคล่ือนทีเ่ร็วแลวคอย ๆ ชา 

    ง. เคล่ือนทีช่าแลวเร็วข้ึน 
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ได 59. การทดสอบการเคลื่อนไหวของภาพ  

ทําไดโดยการกดคียลัดในขอใด 

    ก. Ctrl + Y 

    ข. Ctrl + Enter 

    ค. Ctrl + n 

    ง. Ctrl + e 

60. คําส่ังขอใดทําใหวัตถุเคล่ือนไหวใน

ลักษณะหมุนตามเข็มนาฬกิา  

ก. CCW  

ข. CW  

ค. WC  

ง. WWC  

61. ขอใด  ไมใชเปนการสราง

ภาพเคลื่อนไหวแบบ  Motion  Tween 

    ก. เด็กกําลังคลาน 

    ข. คนเปล่ียนเปนหุนยนต 

    ค. ดวงอาทติยกําลังตกดิน 

    ง. รถยนตกาํลังแลน 

62. การกาํหนดคุณสมบัติของ   

Motion  Tween  ใหกาํหนดคาที่ใด 

    ก. Properties 

    ข. Fiters 

    ค. Parameters 

    ง. File 

63. การกาํหนดชื่อ  Frame  เมื่อกําหนด

ชื่อจะปรากฏธงสีอะไร 

    ก. สีดํา 

    ข. สีขาว 
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    ค. สีแดง 

    ง. สีเขียว 

64. ขอใด  ไมใช  การกาํหนดรูปแบบของ

การสรางภาพเคลื่อนไหวแบบ  Tween 

    ก. None 

    ข. No 

    ค. Motion 

    ง. Shape 

65. Erase  ถากําหนดคาตัวเลข 

มากกวา  0  หมายความวาอยางไร 

    ก. การเคล่ือนที่แบบสม่าํเสมอ 

    ข. การเคลือ่นที่ชาเร็วสลับกัน 

    ค. การเคลือ่นที่เร่ิมตนชาแลว 

คอย ๆ เร็ว 

    ง. การเคลือ่นที่เร่ิมตนเร็วแลว 

คอย ๆ ชา 

66. ภาพเคลื่อนไหวแบบ  Motion  Tween  

เปนการสรางภาพเคลื่อนไหวลักษณะใด 

    ก. กําหนดจุดเร่ิมตน 

    ข. กําหนดจุดส้ินสุด 

    ค. กําหนดจุดศูนยกลาง 

    ง. กําหนดจุดเร่ิมตนและจุดส้ินสุด 

67. Frame  Label  เมื่อกําหนดช่ือ   

จะปรากฏที่สวนใด 

    ก. Layer 

    ข. Frame 

    ค. KeyFrame 

    ง. Timeline 
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68. การทําภาพเคล่ือนไหวแบบ   

Motion  Tween  เราทาํการยอ-ขยาย-

หมุนวัตถ ุ ใชเคร่ืองมือใด 

    ก. Arrow  Tool 

    ข. Free  Transform  Tool 

    ค. Pen  Tool 

    ง. Rectangle  Tool 

หนวยที่  5 การสราง

ภาพเคล่ือนไหว แบบ 

Motion Guide 

1. อธิบายเก่ียวกับ

ขั้นตอนและหลักการ

ในการสราง

ภาพเคล่ือนไหวโดยให

วัตถุหรือภาพที่

กําหนดเคล่ือนที่ไป

ตามเสนทางที ่

ไดกําหนดเอาไวได

อยางถูกตอง 

2. สามารถสราง

ภาพเคล่ือนไหวโดยให

วัตถุหรือภาพที่

กําหนดเคล่ือนที่ไป

ตามเสนทางทีไ่ด

กําหนดเอาไว ได
ถูกตองและสวยงาม 

69. ข้ันตอนการจัดตําแหนงวัตถุใหติดกับ

เสนกริด  คือขอใด 

    ก. View > Snapping > Snap to Pixel 

    ข. View > Snapping >  

Snap to Object 

    ค. View > Snapping > Snap to Grid 

    ง. View > Snapping >  

Snap to Guide 

70. เลือกคําส่ัง  Create  Motion  Tween  

ที่  Timeline  จะปรากฏอะไร 

    ก. ลูกศรดํา 

    ข. ลูกศรแดง 

    ค. ปรากฏรูปภาพ 

    ง. จุดอางอิงตําแหนง 

71. การเปล่ียนวงกลมใหเปน  Symbol  

ใชคําส่ังใด 

    ก. File > Invert   to  Symbol 

    ข. File > Convert   to  Symbol 

    ค. Modify > Invert   to  Symbol 

    ง. Modify > Convert   to  Symbol 
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72. ขอใด  หมายถงึ  วงกลมไดสัมผัสกับ

เสนแลว 

    ก. วางใหเกดิวงกลมเล็กตรงกลาง 

    ข. วางใหเกดิวงกลมใหญตรงกลาง 

    ค. วางใหเกดิวงรีเล็กตรงกลาง 

    ง. วางใหเกดิวงรีใหญตรงกลาง 

73. การซอน  Guideline  ตองคลิกที ่

สวนใด 

    ก. เหนือ  Layer 

    ข. ใต  Layer 

    ค. เหนือตา 

    ง. ใตตา 

74. Guideline  เรียกอีกอยางหนึง่วา 

    ก. Pass 

    ข. Path 

    ค. Pat 

    ง. Paste 

75. ภาพที่กาํหนดเคล่ือนที่ไปตามเสนทาง

ที่ไดกําหนดไวโดยผานตัวใด 

    ก. Guideline 

    ข. Gridline 

    ค. Rulers 

    ง. Snapping 

76. ขอใด  ไมอยู  ในคําส่ัง  Grid 

    ก. Snap  Align 

    ข. Snap  to  Grid 

    ค. Snap  to  Guides 

    ง. Snap  to  Inch 
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77. เมื่อเร่ิมวาดเสน Guideline  เราใช

เคร่ืองมือในขอใดเลือกแบบ Ink 

    ก. Pen Tool 

    ข. Pencil Tool 

    ค. Arrow Tool 

    ง. Rectangle Tool 

โดยใชPencil Tool 

78. คําส่ัง  Modify>Convert  to  Symbol  

สามารถกดปุมใดแทนได 

    ก. F2 

    ข. F4 

    ค. F6 

    ง. F8 

79. การสรางภาพเคล่ือนไหวแบบ  

Motion  Guide  รูปแบบที่ใชเปนแบบใด 

    ก. Movie  Clip 

    ข. Button 

    ค. Graphic 

    ง. Animation 

80. เมื่อทาํการ  Convert   รูปวงกลมเปน 

Symbol  แบบ Graphic  จะถูกเก็บไวที่ใด 

    ก. Stage 

    ข. Library 

    ค. Scene 

    ง. Frame 
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หนวยที่  6 การใชงาน 

Layer Mask 

1. อธิบายวิธีการสราง

และข้ันตอนการ

ซอนเลเยอร ได 

2. สามารถสรางงาน

ภาพเคล่ือนไหวแบบ

ซอนเลเยอร ได 

3. สามารถนําวิธีการ

ซอนเลเยอรไป

ประยุกตสรางงาน

ภาพเคล่ือนไหว แบบ

ตาง ๆ ได 

81. ขอใด   ไม  เกี่ยวของกบั Layer 

    ก. กําหนดใหภาพแสดงหรือไมแสดง 

    ข. ใชแบงภาพเปนช้ินเล็กๆ 

    ค. ที่แสดงชิน้งานที่นาํมาวางออกแบบ 

    ง. เปรียบเหมือนแผนใส 

82.       Layer   เปรียบเหมือกับอะไร 

    ก. หนาเอกสาร 

    ข. หนากระดาษทาํการ 

    ค. หนาตางของงาน 

    ง.  แผนใส  

83. สัญลักษณของการแทรก  Layer   คือ

ขอใด 

    ก.  

    ข.  

    ค.  

    ง.  

84. สัญลักษณ       มีหนาที่อะไร 

    ก. เปด – ปด  การแสดงช้ินงาน

ใน  Layer 

    ข. เปด – ปด  การแสดงช้ินงาน

ใน  Movie 

    ค. ล็อค – ปลดล็อค  ชิ้นงานใน  Layer 

    ง. ล็อค – ปลดล็อค  ชิ้นงานใน  Movie  

85. สัญลักษณ       มีหนาที่อะไร 

    ก. เปด – ปด  การแสดงช้ินงาน

ใน  Layer 
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    ข. เปด – ปด  การแสดงช้ินงาน

ใน  Movie 

    ค. ล็อค – ปลดล็อค  ชิ้นงานใน  Layer 

    ง. ล็อค – ปลดล็อค  ชิ้นงานใน  Movie  

86. การทดสอบการเคลื่อนไหว  ตองคลิก

ที่เมนูใด 

    ก. File > Test  Movie 

    ข. View > Test  Movie 

    ค. Modify > Test  Movie 

    ง. Control > Test  Movie 

87. การสรางภาพเคล่ือนไหวโดยใช  

Layer  Mask  มีลักษณะเปนเชนไร 

    ก. ซอน  Layer  ที่อยูตํ่ากวาไมให 

ถูกมองเหน็ 

    ข. ซอน  Layer   ที่อยูสูงกวาไมให 

ถูกมองเหน็ 

    ค. ซอน  Layer   เฉพาะสวนที่เลือก 

    ง. ซอน  Layer   ทัง้หมด 

88. Mask  Layer  กําหนดข้ึนเพื่ออะไร 

    ก. ใหมองเห็นเฉพาะเนื้อหาในชอง

เทานัน้ 

    ข. ใหมองเห็นเฉพาะเนื้อหานอกชอง

เทานัน้ 

    ค. ใหมองเห็นเฉพาะเนื้อหาทั้งในและ

นอกชอง 

    ง. ใหมองเห็นเฉพาะเนื้อหาทั้งหมด 
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89. คําส่ังใด  ใชแยกตัวอักษรออกทีละตัว 

    ก. Convert  to  Symbol 

    ข. Insert  KeyFrame 

    ค. Break  Apart 

    ง. Remove  Frame 

90. ขอใด  ไมใช  การทดสอบ

ภาพเคลื่อนไหว 

    ก. กดปุม Enter 

    ข. กดคียลัด Ctrl + Enter 

    ค. กดคียลัด Alt + Enter 

    ง. คลิกคําส่ัง Control >Test Movie 

หนวยที่  7 การสราง

ตัวอักษรแบบ 

คาราโอเกะ 

1. อธิบายลักษณะ

และหลักการทํางาน

ของตัวอักษรแบบคา

ราโอเกะได 

2. สามารถสรางการ

เคล่ือนไหวของ

ตัวอักษรแบบคาราโอ

เกะ และนําไป

ประยุกตใชกับชิ้นงาน

ของตนเองได 

91. ขอใด  หมายถงึ  ตัวอักษรแบบ 

คาราโอเกะ 

    ก. แสดงภาพ 

    ข. แสดงเนือ้รอง 

    ค. แสดงวีดีโอ 

    ง. แสดงภาพและเนื้อรอง 

92. ขอใด  คือ  หลักการทาํงานของ

ตัวอักษรคาราโอเกะ 

    ก. มีเนื้อรองข้ึนตน 

    ข. มีเพลงข้ึนตน 

    ค. มีคลิปวดีีโอข้ึนตน 

    ง. มเีสียงตอนรับ 

93. ข้ันตอนแรกของการสรางตัวอักษร

แบบคาราโอเกะ  ตองคลิกที่เมนูใด 

    ก. Timeline 

    ข. Timeline  Effect 

    ค. Scene 
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    ง. New  Symbol 

94. Mask  หมายถงึ  ขอใด 

    ก. สรางตัวอักษรทั้งประโยค 

    ข. รอการระบายสี 

    ค. ใชสีใหมเพื่อเปนตัวระบาย 

    ง. ใชเปนหนากากเพื่อทําการระบายสี

ใหกับประโยค 

95. ขอใด  ไมใช  Layer ที่ใชในการสราง

ตัวอักษรแบบคาราโอเกะ 

    ก. เดิม 

    ข. ปจจุบัน 

    ค. ใหม 

    ง. Mask 

96. การสรางตัวอักษรคาราโอเกะ  

รูปแบบของ  Symbol  เปนแบบใด 

    ก. Movie  Clip 

    ข. Button 

    ค. Graphic 

    ง. Animation 

97. การสรางตัวอักษรคาราโอเกะ  

สามารถกําหนดสีตัวอักษรไดคร้ังละกี่สี 

    ก. 1  สี 

    ข. 2  สี 

    ค. 3  สี 

    ง. 4  สี 
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98. เมื่อตองการใชมูฟวี่คลิป ใหเปด

เคร่ืองมือในขอใด  

    ก. Stage 

    ข. Library 

    ค. Frame 

    ง. KeyFrame 

99. เมื่อตองการทดสอบการแสดงผล 

ตองเขาไปที่เมนูในขอใด 

    ก. Control > Play 

    ข. Control > Playing 

    ค. Insert > Play 

    ง. Insert > Playing 

100. การใสเนือ้เพลงแบบคาราโอเกะ 

ไม สามารถนาํไปประยุกตใชกับงานใน 

ขอใด 

    ก. ทํานิทาน 

    ข. ทําโฆษณา 

    ค. ตกแตงเว็บไซต 

    ง. ตัดตอภาพยนต 

ความคิดเหน็อ่ืน ๆ 

............................................................................................................................................... 

............................................................................................................................................... 

............................................................................................................................................... 

 

    ลงช่ือ................................................ 

           (...............................................) 

                 ผูประเมิน 

     ........../............../.............. 
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แบบประเมินคุณภาพของบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบรวมมือ 
เทคนิค  TGT  เรื่อง คอมพิวเตอรมัลติมีเดีย  สาํหรับนักเรยีนชัน้มัธยมศึกษาปที่  4 

(สําหรับผูเชีย่วชาญ) 
 

หัวขอวิจัย  เร่ือง  การพัฒนาบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบรวมมือ เทคนิค  TGT  

เร่ือง คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษาปที่  4 
 

ผูวิจัย นางศุภลักษณ  ขวัญแสน 
 

วัตถุประสงคงานวจิัย 
1.  เพื่อพัฒนาและหาประสิทธิภาพของบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบ

รวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษาปที่  4 

2.  เพื่อหาความกาวหนาทางการเรียนของผูเรียนดวยบทเรียนบนเครือขายตามรูปแบบ

การเรียนรูแบบรวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษา

ปที่  4 

3.  เพื่อศึกษาความคิดเห็นของผูเรียนที่มีตอการใชบทเรียนบนเครือขายตามรูปแบบ   

การเรียนรูแบบรวมมือเทคนิค  TGT  เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษา

ปที่  4 
 

คําชี้แจง 
1.  แบบประเมินฉบับนี้มีวัตถุประสงคเพื่อสอบถามผูเช่ียวชาญดานการออกแบบพัฒนา

บทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบรวมมือ เทคนิค  TGT  เร่ือง คอมพิวเตอรมัลติมีเดีย

สําหรับนักเรียนช้ันมัธยมศึกษาปที่  4  และนําผลการวิเคราะหไปพัฒนาบทเรียนตอไป 

  2.  รายการประเมินของบทเรียนบนเครือขาย  กรุณาทําเครื่องหมาย          ตามความ

คิดเห็นของทานลงในชองระดับคุณภาพ  โดยแบงระดับคุณภาพออกเปน  5  ระดับ  ดังนี้ 

          5  หมายถึง ดีมาก 

          4  หมายถึง มาก 

          3  หมายถึง ปานกลาง 

          2  หมายถึง นอย 

          1  หมายถึง นอยที่สุด 

3.  หากทานมขีอเสนอแนะกรุณาเพิ่มเติมลงในชอง  ขอเสนอแนะ 
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แบบประเมินคุณภาพของบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบรวมมือ 
เทคนิค  TGT  เรื่อง คอมพิวเตอรมัลติมีเดีย  สาํหรับนักเรยีนชัน้มัธยมศึกษาปที่  4 

(สําหรับผูเชีย่วชาญ) 
 

ระดับคุณภาพ 
รายการประเมิน 

5 4 3 2 1 
ขอ 

เสนอแนะ 
1. ดานลักษณะสาํคัญของบทเรียนเครือขายอินเทอรเน็ต 

    1.1 ผูเรียนสามารถเรียกดูเนื้อหาตามความสะดวกของผูเรียน       

    1.2 มกีารนาํเสนอเนื้อหาโดยใชส่ือมัลติมีเดียเพื่อใหเกดิความ

คงทนในการเรียนรู 

      

    1.3 มกีารนาํเสนอเนื้อหาที่ไมเชิงเปนเสนตรง       

    1.4 ผูเรียนมีโอกาสปฏิสัมพันธกับผูสอนได        

    1.5 มกีารวดัผลประเมินผล       

2. ดานองคประกอบของบทเรียนเครือขายอินเทอรเน็ต 

    2.1 ขอแนะนําวิธีการใชบทเรียนบนเครือขายอินเทอรเน็ต

ดึงดูดความสนใจเขาใจงาย 

      

    2.2 มกีารจดัเว็บเพจสนับสนุนการเรียนที่ผูเรียนสามารถ

เชื่อมโยงเขาไปเรียนรูหรือศึกษาไดงาย 

      

    2.3 มกีารออกแบบชัดเจนและสม่ําเสมอของเว็บเพจไม

กอใหเกิดความสับสนของปุมตางๆ  

      

    2.4 ขอความแตละหนามคีวามยาวเหมาะสม       

    2.5 การใชสีพื้นหลังและตัวอักษรเหมาะสมตอสายตา       

3. ดานการติดตอสื่อสารในบทเรียนเครือขายอินเทอรเน็ต 

    3.1 มีไปรษณียอิเล็กทรอนิกส (E-mail) ที่ผูเรียนสามารถ

ติดตอกับผูสอนได 

      

    3.2 มกีารจดัใหมีกระดานขาว (Webboard) เพื่อใหผูเรียน

แลกเปล่ียนความคิดเหน็ขาวสารและความรูระหวางเรียนดวย

กันเอง และระหวางผูเรียนกบัผูสอนได  

      

    3.3 การติดตอส่ือสารผานหองสนทนาอิเล็กทรอนกิส  

(Chat  Room) 
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ระดับคุณภาพ 
รายการประเมิน 

5 4 3 2 1 
ขอ 

เสนอแนะ 
4. ดานเนื้อหาและการนําเสนอในบทเรียนเครือขายอินเทอรเนต็ 

    4.1 เนื้อหามีความสอดคลองกับผลการเรียนรู       

    4.2 เนื้อหามีความเหมาะสมกับระดับผูเรียน        

    4.3 เนื้อหามีความถูกตอง       

    4.4 มกีารจดัลําดับเนื้อหาจากงายไปหายาก       

    4.5 มกีารเชื่อมโยงไปสูเนื้อหาในเว็บไซตอ่ืนเพื่อใหผูเรียนมี

โอกาสคนควาเพิ่มเติม 

      

    4.6 มีภาพประกอบที่เหมาะสม ถูกตองตามเนื้อหา       

    4.7 ใชภาษาถูกตองและเหมาะสม       

5. ดานแบบฝกหัดและแบบทดสอบในบทเรียนบนเครือขายอินเทอรเน็ต 

    5.1 คําถามของแบบทดสอบมีความชัดเจน       

    5.2 แบบฝกหัดและแบบทดสอบมีความสอดคลองกบัเนื้อหา       

6. ดานการจดักิจกรรมการเรียนรูแบบรวมมือ 

    6.1 กิจกรรมที่จัดในการเรียนดวยบทเรียนบนเครือขาย

อินเทอรเน็ต เปนกิจกรรมทีส่งเสริมการเรียนรูแบบรวมมือ 

      

    6.2 การจัดกิจกรรมการเรียนรูแบบรวมมือสอดคลองกับผล 

การเรียนรู 

      

   6.3 การจัดกิจกรรมการเรียนรูแบบรวมมือสอดคลองกับเนื้อหา       

   6.4 การจัดกิจกรรมการเรียนรูแบบรวมมือเหมาะสมกบัผูเรียน       
 

ขอเสนอแนะ 
............................................................................................................................................... 

............................................................................................................................................... 

 

ลงช่ือ..................................................... 

           (.......................................................) 

                                                                                            ผูประเมนิ 
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แบบประเมินความคิดเห็นของบทเรียนบนเครือขายตามรูปแบบการเรยีนรูแบบรวมมือ 
เทคนิค  TGT  เรื่อง คอมพิวเตอรมัลติมีเดีย  สาํหรับนักเรยีนชัน้มัธยมศึกษาปที่  4 

(สําหรับนักเรียน) 

 
คําชี้แจง     

โปรดพิจารณาวาบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบรวมมือเทคนิค  TGT  

เร่ือง คอมพวิเตอรมัลติมีเดีย  สําหรับนกัเรียนช้ันมัธยมศึกษาปที่  4  วามีความเหมาะสมในประเด็น

ตาง ๆ โดยทาํเคร่ืองหมาย           ลงในชองที่ตรงกับความคิดเห็นของทาน 

            5  หมายถึง ดีมาก 

           4  หมายถึง มาก 

           3  หมายถึง ปานกลาง 

           2  หมายถึง นอย 

           1  หมายถึง นอยที่สุด 
 
 
 

ระดับคุณภาพ 
รายการประเมิน 

5 4 3 2 1 
ขอ 

เสนอแนะ 
1. ดานปจจัยนําเขา 

    1.1 เนื้อหามีความเหมาะสม       

    1.2 การออกแบบเว็บเพจมีความสวยงาม       

    1.3 ขอความและภาพส่ือความหมายไดชัดเจนและเขาใจงาย       

    1.4 มีแหลงสนับสนนุการเรียนรูที่เหมาะสม       

    1.5 การออกแบบเมนูสวนนาํทางเขาใจงายและสะดวก       

2. ดานกระบวนการ 

    2.1 มกีารแจงผลการเรียนที่ชัดเจน       

    2.2 เนื้อหามีความสอดคลองกับผลการเรียน       

    2.3 มกีารยกตัวอยางประกอบที่เหมาะสม       

    2.4 ข้ันตอนในการเรียนรูแบบรวมมือ  TGT  งาย  สะดวก       
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ระดับคุณภาพ 
รายการประเมิน 

5 4 3 2 1 
ขอ 

เสนอแนะ 

    2.5 ข้ันตอนในการเรียนรูแบบรวมมือ  TGT  เปดโอกาส 

ใหแลกเปล่ียนเรียนรูความคิดเห็นซ่ึงกนัและกัน 

      

3. ดานผลลพัธ 

    3.1 การเรียนดวยบทเรียนบนเครือขายโดยการเรียนรูแบบ

รวมมือ 

แบบ  TGT  ชวยให 

      

         3.1.1 นกัเรียนมีความเขาใจในบทเรียนไดดี       

         3.1.2 นักเรียนไดเรียนตามความสามารถของตน       

         3.1.3 บรรยากาศในการเรียนไมตึงเครียด       

         3.1.4 นกัเรียนจดจําความรูไดนานข้ึน       

         3.1.5 นกัเรียนแกไขสวนที่ยงับกพรองหรืออความรูในสวน 

ที่ยงัไมเขาใจ 

      

    3.2  กิจกรรมกลุมทาํใหนกัเรียนมีความกระตือรือลน  ไมเบ่ือ

หนายในการเรียน 

      

    3.3 นักเรียนมีความเขาใจในข้ันตอนการเรียนรูแบบรวมมือ

แบบ  TGT   

      

    3.4 กิจกรรมการเรียนรูทาํใหมีความเขาใจในเนื้อหาที่ยากไดดี       

    3.5 นักเรียนตองการใหมกีารใชบทเรียนบนเครือขายโดยการ

เรียนรูแบบรวมมือ  เทคนิค  TGT  ในเนื้อหาวิชาอ่ืน ๆ อีก 

      

 

ขอเสนอแนะ 
............................................................................................................................................... 

............................................................................................................................................... 

............................................................................................................................................... 

 

ขอบคุณ 
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ภาคผนวก  ง 
 

คาคํานวณทางสถิติ 
 

1.  ผลการประเมินความสอดคลองดานสาระการเรียนรูกับผลการเรียนรู 

2.  ผลการประเมินความสอดคลองดานผลการเรียนรูกับแบบทดสอบ 

  3.  ผลการวิเคราะหคาความยากงาย คาอํานาจจําแนก และคาความเชื่อมั่น 

  4.  ผลการวิเคราะหการหาคาประสิทธิภาพบทเรียนบนเครือขายเครือขาย 

 5.  ผลการประเมินคุณภาพของบทเรียนเครือขาย 

   6.  ผลความคิดเห็นของนักเรียนทีม่ีตอบทเรียนบนเครือขาย 

   7.  คะแนนเฉล่ียของกลุม  หลังจากเลนเกมการแขงขัน (TGT)  ในหนวยที ่ 1 – 7 
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ตาราง  9  แสดงผลการประเมินความสอดคลองดานสาระการเรียนรูกบัผลการเรยีนรู 
 

ความคิดเห็น 
ขอที่ คนที่

1 
คนที่

2 
คนที่

3 

IOC แปลผล 

1 1 1 1 1.00 ใชได 

2 1 1 1 1.00 ใชได 

3 1 1 1 1.00 ใชได 

4 1 1 1 1.00 ใชได 

5 1 1 1 1.00 ใชได 

6 1 0 1 0.67 ใชได 

7 1 0 1 0.67 ใชได 

8 1 1 1 1.00 ใชได 

9 1 0 1 0.67 ใชได 

10 1 1 1 1.00 ใชได 

11 1 0 1 0.67 ใชได 

12 1 1 1 1.00 ใชได 

13 1 0 1 0.67 ใชได 

14 1 0 1 0.67 ใชได 

15 1 1 1 1.00 ใชได 

16 1 0 1 0.67 ใชได 
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ตาราง  10  แสดงผลการประเมินความสอดคลองระหวางผลการเรียนรูกับ 
                แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน  เรื่อง  คอมพิวเตอรมัลติมีเดีย  

   

ความคิดเห็นผูเชี่ยวชาญ 
ขอสอบขอที ่

คนที่  1 คนที่  2 คนที่  3 
คา  IOC แปลผล 

1 1 1 1 1.00 สอดคลอง 

2 1 1 1 1.00 สอดคลอง 

3 1 1 1 1.00 สอดคลอง 

4 1 1 1 1.00 สอดคลอง 

5 1 1 1 1.00 สอดคลอง 

6 1 1 1 1.00 สอดคลอง 

7 1 1 1 1.00 สอดคลอง 

8 1 1 1 1.00 สอดคลอง 

9 1 1 1 1.00 สอดคลอง 

10 1 1 1 1.00 สอดคลอง 

11 1 1 1 1.00 สอดคลอง 

12 1 1 1 1.00 สอดคลอง 

13 1 1 1 1.00 สอดคลอง 

14 1 1 1 1.00 สอดคลอง 

15 1 1 1 1.00 สอดคลอง 

16 1 1 1 1.00 สอดคลอง 

17 1 1 1 1.00 สอดคลอง 

18 1 1 1 1.00 สอดคลอง 

19 1 1 1 1.00 สอดคลอง 

20 1 1 1 1.00 สอดคลอง 

21 1 1 1 1.00 สอดคลอง 

22 1 1 1 1.00 สอดคลอง 

23 1 1 1 1.00 สอดคลอง 
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ตาราง 10 (ตอ) 

 

ความคิดเห็นผูเชี่ยวชาญ 
ขอที่ 

คนที่1 คนที่2 คนที่3 
คา  IOC แปลผล 

24 1 1 1 1.00 สอดคลอง 

25 1 1 1 1.00 สอดคลอง 

26 1 1 1 1.00 สอดคลอง 

27 1 1 1 1.00 สอดคลอง 

28 1 1 1 1.00 สอดคลอง 

29 1 1 1 1.00 สอดคลอง 

30 1 1 1 1.00 สอดคลอง 

31 1 1 1 1.00 สอดคลอง 

32 1 1 1 1.00 สอดคลอง 

33 1 0 1 0.67 สอดคลอง 

34 1 1 1 1.00 สอดคลอง 

35 1 1 1 1.00 สอดคลอง 

 36 1 1 1 1.00 สอดคลอง 

 37 1 1 1 1.00 สอดคลอง 

 38 1 1 1 1.00 สอดคลอง 

 39 1 1 1 1.00 สอดคลอง 

 40 1 1 1 1.00 สอดคลอง 

 41 1 1 1 1.00 สอดคลอง 

 42 1 1 1 1.00 สอดคลอง 

 43 1 1 1 1.00 สอดคลอง 

 44 1 1 1 1.00 สอดคลอง 

 45 1 1 1 1.00 สอดคลอง 

 46 1 1 1 1.00 สอดคลอง 

 47 1 1 1 1.00 สอดคลอง 
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ตาราง 10 (ตอ) 

 

ความคิดเห็น 
ขอที่ 

คนที่1 คนที่2 คนที่3 
คา  IOC แปลผล 

 48 1 1 1 1.00 สอดคลอง 

 49 1 1 1 1.00 สอดคลอง 

 50 1 1 1 1.00 สอดคลอง 

 51 1 1 1 1.00 สอดคลอง 

 52 1 1 1 1.00 สอดคลอง 

 53 1 1 1 1.00 สอดคลอง 

 54 1 1 1 1.00 สอดคลอง 

 55 1 1 1 1.00 สอดคลอง 

 56 1 1 1 1.00 สอดคลอง 

 57 1 1 1 1.00 สอดคลอง 

 58 1 1 1 1.00 สอดคลอง 

 59 1 1 1 1.00 สอดคลอง 

 60 1 1 1 1.00 สอดคลอง 

 61 1 1 1 1.00 สอดคลอง 

 62 1 1 1 1.00 สอดคลอง 

 63 1 0 1 0.67 สอดคลอง 

 64 1 1 1 1.00 สอดคลอง 

 65 1 -1 1 0.33 ไมสอดคลอง 

 66 1 1 1 1.00 สอดคลอง 

 67 1 0 1 0.67 สอดคลอง 

 68 1 1 1 1.00 สอดคลอง 

 69 1 1 1 1.00 สอดคลอง 

 70 1 0 1 0.67 สอดคลอง 

 71 1 0 1 0.67 สอดคลอง 
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ตาราง 10 (ตอ) 
 

ความคิดเห็น 
ขอที่ 

คนที่1 คนที่2 คนที่3 
คา  IOC แปลผล 

 72 1 1 1 1.00 สอดคลอง 

 73 1 1 1 1.00 สอดคลอง 

 74 1 1 1 1.00 สอดคลอง 

 75 1 1 1 1.00 สอดคลอง 

76 1 1 1 1.00 สอดคลอง 

 77 1 1 1 1.00 สอดคลอง 

 78 1 -1 1 0.33 ไมสอดคลอง 

 79 1 1 1 1.00 สอดคลอง 

 80 1 0 1 0.67 สอดคลอง 

 81 1 1 1 1.00 สอดคลอง 

 82 1 1 1 1.00 สอดคลอง 

 83 1 1 1 1.00 สอดคลอง 

 84 1 0 1 0.67 สอดคลอง 

 85 1 1 1 1.00 สอดคลอง 

 86 1 1 1 1.00 สอดคลอง 

 87 1 1 1 1.00 สอดคลอง 

 88 1 1 1 1.00 สอดคลอง 

 89 1 1 1 1.00 สอดคลอง 

 90 1 0 1 0.67 สอดคลอง 

 91 1 1 1 1.00 สอดคลอง 

 92 1 1 1 1.00 สอดคลอง 

 93 1 1 1 1.00 สอดคลอง 

 94 1 0 1 0.67 สอดคลอง 
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ตาราง   10   (ตอ) 
 

ความคิดเห็น 
ขอที่ 

คนที่1 คนที่2 คนที่3 
คา  IOC แปลผล 

 95 1 1 1 1.00 สอดคลอง 

 96 1 1 1 1.00 สอดคลอง 

 97 1 1 1 1.00 สอดคลอง 

 98 1 1 1 1.00 สอดคลอง 

99 1 1 1 1.00 สอดคลอง 

 100 1 1 1 1.00 สอดคลอง 
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ตาราง  11  แสดงคาความยากงาย คาอํานาจจาํแนก และคาความเช่ือม่ันของแบบทดสอบ 
                

ความยากงาย (P) อํานาจจาํแนก (D) 
ขอที่ 

0.2-0.8 0.2-1 
ผลการทดสอบ 

1 0.63 0.65 นําไปใช 

2 0.75 1.00 นําไปใช 

3 0.80 0.40 นําไปใช 

4 0.73 0.55 นําไปใช 

5 0.68 0.65 นําไปใช 

6 0.75 0.45 นําไปใช 

7 0.70 0.60 นําไปใช 

8 0.80 0.60 นําไปใช 

9 0.75 0.40 นําไปใช 

10 0.73 0.45 นําไปใช 

11 0.75 0.40 นําไปใช 

12 0.78 0.45 นําไปใช 

13 0.70 0.40 นําไปใช 

14 0.63 0.55 นําไปใช 

15 0.50 0.70 นําไปใช 

16 0.58 0.25 นําไปใช 

17 0.68 0.45 นําไปใช 

18 0.75 0.40 นําไปใช 

19 0.78 0.45 นําไปใช 

20 0.73 0.55 นําไปใช 

21 0.63 0.75 นําไปใช 

22 0.58 0.65 นําไปใช 

23 0.63 0.25 นําไปใช 



 143 

ตาราง  11  (ตอ) 
 

ความยากงาย (P) อํานาจจาํแนก (D) 
ขอที่ 

0.2-0.8 0.2-1 
ผลการทดสอบ 

24 0.70 0.50 นําไปใช 

25 0.60 0.60 นําไปใช 

26 0.75 0.50 นําไปใช 

27 0.68 0.85 นําไปใช 

28 0.73 0.35 นําไปใช 

29 0.75 0.50 นําไปใช 

30 0.68 0.45 นําไปใช 

31 0.58 0.75 นําไปใช 

32 0.65 0.50 นําไปใช 

33 0.68 0.25 นําไปใช 

34 0.65 0.50 นําไปใช 

35 0.70 0.50 นําไปใช 

36 0.63 0.25 นําไปใช 

37 0.63 0.35 นําไปใช 

38 0.75 0.40 นําไปใช 

39 0.65 0.30 นําไปใช 

40 0.73 0.45 นําไปใช 

41 0.75 0.30 นําไปใช 

42 0.63 0.45 นําไปใช 

43 0.65 0.30 นําไปใช 

44 0.63 0.45 นําไปใช 

45 0.70 0.60 นําไปใช 

46 0.68 0.45 นําไปใช 
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ตาราง  11  (ตอ) 
 

ความยากงาย (P) อํานาจจาํแนก (D) 
ขอที่ 

0.2-0.8 0.2-1 
ผลการทดสอบ 

47 0.60 0.60 นําไปใช 

48 0.70 0.50 นําไปใช 

49 0.68 0.45 นําไปใช 

50 0.63 0.45 นําไปใช 

51 0.65 0.40 นําไปใช 

52 0.60 0.50 นําไปใช 

53 0.70 0.40 นําไปใช 

54 0.68 0.65 นําไปใช 

55 0.70 0.40 นําไปใช 

56 0.70 0.60 นําไปใช 

57 0.63 0.45 นําไปใช 

58 0.65 0.60 นําไปใช 

59 0.60 0.60 นําไปใช 

60 0.65 0.60 นําไปใช 

61 0.60 0.60 นําไปใช 

62 0.68 0.35 นําไปใช 

63 0.70 0.50 นําไปใช 

64 0.75 0.40 นําไปใช 

65 0.80 0.40 นําไปใช 

66 0.68 0.35 นําไปใช 

67 0.73 0.35 นําไปใช 

68 0.75 0.40 นําไปใช 

69 0.75 0.50 นําไปใช 
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ตาราง  11  (ตอ) 
 

ความยากงาย (P) อํานาจจาํแนก (D) 
ขอที่ 

0.2-0.8 0.2-1 
ผลการทดสอบ 

70 0.65 0.50 นําไปใช 

71 0.53 0.45 นําไปใช 

72 0.73 0.55 นําไปใช 

73 0.65 0.30 นําไปใช 

74 0.60 0.40 นําไปใช 

75 0.63 0.25 นําไปใช 

76 0.70 0.50 นําไปใช 

77 0.70 0.40 นําไปใช 

78 0.60 0.80 นําไปใช 

79 0.58 0.35 นําไปใช 

80 0.68 0.25 นําไปใช 

81 0.55 0.40 นําไปใช 

82 0.70 0.60 นําไปใช 

83 0.63 0.35 นําไปใช 

84 0.73 0.35 นําไปใช 

85 0.80 0.40 นําไปใช 

86 0.78 0.35 นําไปใช 

87 0.73 0.35 นําไปใช 

88 0.55 0.40 นําไปใช 

89 0.58 0.35 นําไปใช 

90 0.68 0.35 นําไปใช 

91 0.65 0.30 นําไปใช 

92 0.70 0.40 นําไปใช 
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ตาราง  11  (ตอ) 
 

ความยากงาย (P) อํานาจจาํแนก (D) 
ขอที่ 

0.2-0.8 0.2-1 
ผลการทดสอบ 

93 0.75 0.40 นําไปใช 

94 0.55 0.60 นําไปใช 

95 0.73 0.35 นําไปใช 

96 0.70 0.50 นําไปใช 

97 0.63 0.45 นําไปใช 

98 0.73 0.55 นําไปใช 

 

คาความเชื่อมัน่  = 0.89 
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ตาราง  12  แสดงการหาคาประสิทธภิาพบทเรียนบนเครือขายเครือขาย  ตามรูปแบบ 
     การเรยีนรูแบบรวมมือ  เทคนิค TGT  เรื่อง  คอมพิวเตอรมัลติมีเดีย 
     สําหรับนกัเรียนชั้นมัธยมศึกษาปที่  4  โรงเรยีนต้ิววิทยาคม   
     อําเภอหลมสกั  จังหวัดเพชรบูรณ (กลุมตัวอยางที่ใชในการหา 
     ประสิทธภิาพ จํานวน 30 คน ) 

 

คะแนนแบบทดสอบระหวางเรยีน  
(บทเรียนละ 10 คะแนน) คน

ที่ 

แบบทดสอบ
กอนเรียน 

(35 คะแนน) หนวย
ที่ 1 

หนวย
ที่ 2 

หนวย
ที่ 3 

หนวย
ที่ 4 

หนวย
ที่ 5 

หนวย
ที่ 6 

หนวย
ที่ 7 

แบบทดสอบ
หลังเรยีน 

(35 คะแนน) 

1 10 8 9 9 19 9 8 10 32 

2 8 10 8 8 9 8 8 9 30 

3 9 8 9 10 9 9 9 8 27 

4 5 7 8 9 7 8 7 9 28 

5 10 8 8 9 9 10 8 9 30 

6 7 10 6 10 9 8 7 9 27 

7 5 8 7 8 6 8 8 8 29 

8 13 9 9 8 9 9 8 9 30 

9 12 10 10 9 10 9 9 9 32 

10 10 9 9 7 6 9 8 9 30 

11 9 8 6 9 8 8 8 10 27 

12 11 8 8 7 6 7 9 9 29 

13 12 10 8 9 8 8 8 8 29 

14 10 8 9 9 8 8 7 9 34 

15 6 8 9 7 6 7 8 8 25 

16 8 9 8 9 8 10 8 9 31 

17 12 9 10 8 8 9 8 8 32 

18 8 8 7 9 7 8 8 7 27 

19 12 10 8 9 8 10 9 8 30 
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ตาราง 12 (ตอ) 

 

คะแนนแบบทดสอบระหวางเรยีน  
(บทเรียนละ 10 คะแนน) 

คนที่ 

แบบทดสอบ
กอนเรียน 

(35 คะแนน) หนวย 
ที่ 1 

หนวย
ที่ 2 

หนวย
ที่ 3 

หนวย
ที่ 4 

หนวย
ที่ 5 

หนวย
ที่ 6 

หนวย
ที่ 7 

แบบทดสอบ
หลังเรยีน 

(35 คะแนน) 

20 12 9 10 7 8 8 8 9 29 

21 11 8 8 9 8 9 8 8 32 

22 10 10 9 9 8 8 9 10 25 

23 11 9 8 8 9 9 8 8 32 

24 6 8 8 7 9 8 8 9 34 

25 9 9 9 8 10 9 8 9 29 

26 13 10 9 9 8 9 8 10 27 

27 5 8 6 7 8 7 8 7 32 

28 9 9 8 9 9 8 9 8 30 

29 11 8 8 9 8 9 8 9 32 

30 8 7 8 8 9 7 8 7 27 

รวม 260 247 253 245 253 243 257 

คาเฉลี่ย 8.67 8.23 8.43 8.17 8.43 8.10 8.57 

รอยละ 

 

86.67 82.33 84.33 81.67 84.33 81.00 85.67 

E1/E2 E1 = 83.71 

E2 = 82.22 
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ตาราง  13  แสดงการหาคาประสิทธภิาพบทเรียนบนเครือขายเครือขาย  ตามรูปแบบ 
     การเรยีนรูแบบรวมมือ  เทคนิค TGT  เรื่อง  คอมพิวเตอรมัลติมีเดีย 
     สําหรับนกัเรียนชั้นมัธยมศึกษาปที่  4  โรงเรยีนต้ิววิทยาคม   
     อําเภอหลมสกั  จังหวัดเพชรบูรณ (กลุมที่ใชในการทดลอง 
     จาํนวน  36  คน ) 

 

คะแนนแบบทดสอบระหวางเรยีน  
(บทเรียนละ 10 คะแนน) คน

ที่ 

แบบทดสอบ
กอนเรียน 

(35 คะแนน) หนวย
ที่ 1 

หนวย
ที่ 2 

หนวย
ที่ 3 

หนวย
ที่ 4 

หนวย
ที่ 5 

หนวย
ที่ 6 

หนวย
ที่ 7 

แบบทดสอบ
หลังเรยีน 

(35 คะแนน) 

1 11 8 8 9 8 10 8 9 32 

2 5 8 7 8 6 8 8 8 29 

3 5 6 6 7 9 6 6 9 29 

4 8 10 8 8 9 9 7 9 30 

5 13 10 8 8 9 8 10 9 30 

6 8 7 8 8 9 7 8 7 27 

7 9 8 9 7 8 9 8 9 26 

8 11 8 8 9 8 9 8 8 32 

9 13 10 9 8 9 8 9 9 25 

10 13 9 9 8 9 9 8 9 23 

11 12 10 8 9 8 10 9 8 30 

12 5 7 8 9 7 8 7 9 20 

13 10 10 8 9 9 10 8 9 33 

14 5 8 6 7 8 7 8 7 32 

15 13 10 9 9 8 9 8 10 27 

16 8 9 8 9 8 10 8 9 34 

17 10 10 9 9 8 8 9 10 25 

18 11 8 8 7 6 7 9 9 29 

19 9 8 6 9 8 8 8 10 27 
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ตาราง 13 (ตอ) 

 

คะแนนแบบทดสอบระหวางเรยีน  
(บทเรียนละ 10 คะแนน) 

คนที่ 

แบบทดสอบ
กอนเรียน 

(35 คะแนน) หนวย
ที่ 1 

หนวย
ที่ 2 

หนวย
ที่ 3 

หนวย
ที่ 4 

หนวย
ที่ 5 

หนวย
ที่ 6 

หนวย
ที่ 7 

แบบทดสอบ
หลังเรยีน 

(35 คะแนน) 

20 14 10 9 8 8 9 9 10 25 

21 12 9 9 10 8 8 9 9 29 

22 6 9 8 9 9 8 9 8 30 

23 15 9 10 10 8 8 8 9 29 

24 6 8 9 7 6 7 8 8 25 

25 12 9 10 8 8 9 8 8 32 

26 10 8 9 9 8 8 7 9 34 

27 16 10 10 9 10 9 9 9 32 

28 8 8 7 9 7 8 8 7 27 

29 9 9 9 8 10 9 8 9 33 

30 10 10 9 9 10 9 8 10 32 

31 12 10 6 10 9 8 7 9 27 

32 9 8 9 10 9 9 9 8 30 

33 10 9 9 7 6 9 8 7 30 

34 6 8 8 7 9 8 8 9 34 

35 12 10 8 9 8 8 8 10 29 

36 11 9 8 8 9 9 8 8 32 

รวม 317 297 304 296 303 293 314 

คาเฉลี่ย 8.81 8.25 8.44 8.22 8.42 8.14 8.72 

รอยละ 

 

88.06 82.50 84.44 82.22 84.17 81.39 87.22 

E1/E2 E1 = 84.29 

E2 = 83.33 
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ตาราง  14  แสดงผลการประเมินคุณภาพของบทเรียนเครือขาย 
 

ความคิดเห็น
ผูเชี่ยวชาญ รายการประเมิน 

X  SD 

ระดับ
คุณภาพ 

1.  ดานลักษณะสําคัญของบทเรียนบนเครือขาย 

     1.1  ผูเรียนสามารถเรียกดูเนื้อหาตามความสะดวก

ของผูเรียน 

     1.2  มกีารนําเสนอเนื้อหาโดยใชส่ือมัลติมีเดียเพื่อให

เกิดความคงทนในการเรียนรู 

     1.3  มกีารนําเสนอเนื้อหาที่ไมเชงิเปนเสนตรง 

     1.4  ผูเรียนมีโอกาสปฏิสัมพันธกับผูสอนได 

     1.5  มกีารวัดผลประเมินผล 

 

4.33 

 

3.33 

 

3.33 

3.33 

3.67 

 

0.58 

 

1.15 

 

0.58 

0.58 

0.58 

 

ดี 

 

ปานกลาง 

 

ปานกลาง 

ปานกลาง 

ดี 

เฉลี่ย 3.60 0.69 ดี 

2.  ดานองคประกอบของบทเรียนบนเครือขาย 

     2.1 ขอแนะนําวิธกีารใชบทเรียนบนเครือขายดึงดูด

ความสนใจเขาใจงาย 

     2.2 มีการจัดเว็บเพจสนบัสนุนการเรียนที่ผูเรียน

สามารถเชื่อมโยงเขาไปเรียนรูหรือศึกษาไดงาย 

     2.3 มีการออกแบบชัดเจนและสม่าํเสมอของเว็บเพจ

ไมกอใหเกิดความสับสนของปุมตาง ๆ 

     2.4 ขอความแตละหนามีความยาวเหมาะสม 

     2.5 การใชสีพื้นหลังและตัวอักษรเหมาะสมตอ

สายตา 

 

3.67 

 

3.67 

  

3.33 

 

3.67 

3.00 

 

0.58 

 

0.58 

 

0.58 

 

0.58 

0.58 

 

ดี 

 

ดี 

 

ปานกลาง 

 

ดี 

ปานกลาง 

เฉลี่ย 3.47 0.58 ปานกลาง 
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ตาราง  14 (ตอ) 
 

ความคิดเห็น
ผูเชี่ยวชาญ รายการประเมิน 

X  SD 

ระดับ
คุณภาพ 

3.  ดานการติดตอส่ือสารในบทเรียนบนเครือขาย 

     3.1  มีไปรษณียอิเล็กทรอนิกส (E-mail) ที่ผูเรียน

สามารถติดตอกับผูสอนได 

     3.2  มกีารจัดใหมีกระดานขาว (Webboard) เพื่อให

ผูเรียนแลกเปลี่ยนความคิดเห็นขาวสารและความรู

ระหวางเรียนดวยกนัเอง และระหวางผูเรียนกับผูสอนได 

     3.3  การติดตอส่ือสารผานหองสนทนา

อิเล็กทรอนกิส  (Chat  Room) 

 

4.00 

 

3.67 

 

 

4.33 

 

 

1.00 

 

0.58 

 

 

0.58 

 

 

ดี 

 

ดี 

 

 

ดี 

เฉลี่ย 4.00 0.72 ดี 

4.  ดานเนื้อหาและการนําเสนอในบทเรียนบนเครือขาย 

     4.1  เนื้อหามีความสอดคลองกับผลการเรียนรู 

     4.2  เนื้อหามีความเหมาะสมกับระดับผูเรียน  

     4.3 เนื้อหามีความถูกตอง 

     4.4 มีการจัดลําดับเนื้อหาจากงายไปหายาก 

     4.5 มีการเช่ือมโยงไปสูเนื้อหาในเว็บไซตอ่ืนเพื่อให

ผูเรียนมีโอกาสคนควาเพิ่มเติม 

     4.6 มีภาพประกอบที่เหมาะสม ถูกตองตามเนื้อหา 

     4.7 ใชภาษาถกูตองและเหมาะสม 

 

4.00 

4.00 

4.00 

4.00 

3.33 

 

3.33 

  3.67 

 

0.00 

0.00 

0.00 

0.00 

0.58 

 

0.58 

0.58 

 

ดี 

ดี 

ดี 

ดี 

ปานกลาง 

 

ปานกลาง 

ดี 

เฉลี่ย 3.76 0.25 ดี 
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ตาราง  14 (ตอ) 
 

ความคิดเห็น
ผูเชี่ยวชาญ รายการประเมิน 

X  SD 

ระดับ
คุณภาพ 

5.  ดานแบบฝกหัดและแบบทดสอบในบทเรียน 

บนเครือขาย 

     5.1  คําถามของแบบทดสอบมีความชัดเจน 

     5.2  แบบฝกหัดและแบบทดสอบมีความสอดคลอง

กับเนื้อหา 

 

 

3.67 

3.67 

 

 

 

0.58 

0.58 

 

 

 

ดี 

ดี 

เฉลี่ย 3.67 0.58 ดี 

6.  ดานการจดักิจกรรมการเรียนรูแบบรวมมือ 

     6.1  กิจกรรมที่จัดในการเรียนดวยบทเรียนบน

เครือขาย  เปนกิจกรรมที่สงเสริมการเรียนรูแบบรวมมือ 

     6.2  การจดักิจกรรมการเรียนรูแบบรวมมือ

สอดคลองกับผลการเรียนรู 

     6.3  การจดักิจกรรมการเรียนรูแบบรวมมือ

สอดคลองกับเนื้อหา 

     6.4  การจดักิจกรรมการเรียนรูแบบรวมมือ

เหมาะสมกับผูเรียน 

 

3.00 

 

3.00 

 

3.00 

 

3.00 

 

 

1.00 

 

1.00 

 

1.00 

 

1.00 

 

 

ปานกลาง 

 

ปานกลาง 

 

ปานกลาง 

 

ปานกลาง 

 

เฉลี่ย 3.00 1.00 ปานกลาง 
รวมเฉลีย่ 3.58 0.64 ดี 
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ตาราง  15  แสดงผลความคิดเห็นของนักเรียนที่มีตอบทเรียนบนเครือขาย  
                

ความคิดเห็น
นักเรียน รายการประเมิน 

X  SD 

ระดับ
คุณภาพ 

1.  ดานปจจยันําเขา 

    1.1 เนื้อหามีความเหมาะสม 

    1.2 การออกแบบเว็บเพจมีความสวยงาม 

    1.3 ขอความและภาพส่ือความหมายไดชัดเจนและ 

เขาใจงาย 

    1.4 มีแหลงสนับสนนุการเรียนรูที่เหมาะสม 

    1.5 การออกแบบเมนูสวนนาํทางเขาใจงายและ 

สะดวก   

 

4.53 

3.61 

3.69 

 

4.50 

4.22 

 

 

0.51 

0.55 

0.52 

 

0.51 

0.54 

 

 

ดีมาก 

ดี 

ดี 

 

ดีมาก 

ดี 

เฉลี่ย 4.11 0.53 ดี 

2. ดานกระบวนการ 

    2.1 มีการแจงผลการเรียนที่ชัดเจน 

    2.2 เนื้อหามีความสอดคลองกับผลการเรียนรู 

    2.3 มีการยกตัวอยางประกอบที่เหมาะสม 

    2.4 ข้ันตอนในการเรียนรูแบบรวมมือ  TGT  งาย   

สะดวก 

    2.5 ข้ันตอนในการเรียนรูแบบรวมมือ  TGT   

เปดโอกาสใหแลกเปล่ียนเรียนรูความคิดเห็น 

ซึ่งกนัและกนั  

 

4.53 

4.56 

3.56 

 3.50 

 

4.44 

 

 

0.51 

0.50 

0.50 

0.51 

 

0.50 

 

 

ดีมาก 

ดีมาก 

ดี 

ดี 

 

ดี 

 

เฉลี่ย 4.12 0.50 ดี 
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ตาราง  15 (ตอ) 
 

ความคิดเห็น
นักเรียน รายการประเมิน 

X  SD 

ระดับ
คุณภาพ 

3. ดานผลลัพธ 

    3.1 การเรียนดวยบทเรียนบนเครือขายโดยการเรียนรู 

แบบรวมมือแบบ  TGT  ชวยให 

         3.1.1 นักเรียนมีความเขาใจในบทเรียนไดดี 

         3.1.2 นักเรียนไดเรียนตามความสามารถของตน 

         3.1.3 บรรยากาศในการเรียนไมตึงเครียด 

         3.1.4 นักเรียนจดจําความรูไดนานข้ึน 

         3.1.5 นักเรียนแกไขสวนที่ยงับกพรองหรือความรู 

ในสวนทีย่ังไมเขาใจ 

    3.2 กิจกรรมกลุมทาํใหนกัเรียนมีความกระตือรือลน   

ไมเบ่ือหนายในการเรียน 

    3.3 นักเรียนมีความเขาใจในข้ันตอนการเรียนรูแบบ 

รวมมือแบบ  TGT   

    3.4 กิจกรรมการเรียนรูทาํใหมีความเขาใจในเนื้อหา 

ที่ยากไดดี 

    3.5 นักเรียนตองการใหมกีารใชบทเรียนบนเครือขาย 

โดยการเรียนรูแบบรวมมือ  เทคนิค  TGT  ในเนื้อหา 

วิชาอ่ืน ๆ อีก 

 

 

 

4.53 

4.58 

4.72 

4.47 

4.44 

 

4.64 

 

4.06 

 

3.97 

 

4.75 

 

 

 

 

0.51 

0.50 

0.45 

0.51 

0.50 

 

0.49 

 

0.71 

 

0.70 

 

0.44 

 

 

 

 

ดีมาก 

ดีมาก 

ดีมาก 

ดี 

ดี 

 

ดีมาก 

 

ดี 

 

ดี 

 

ดีมาก 

 

เฉลี่ย 4.46 0.53 ดี 
รวมเฉลีย่ 4.23 0.52 ดี 
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ตาราง  16  แสดงคะแนนเฉลี่ยของกลุม  หลังจากเลนเกมการแขงขัน (TGT)   
               ในหนวยที่  1 – 7 
 

กลุมที ่
 หนวย

ที่  1 
หนวย
ที่  2 

หนวย
ที่  3 

หนวย
ที่  4 

หนวย
ที่  5 

หนวย
ที่  6 

หนวย
ที่  7 

สรุป 

X  9.5 9 8.5 9 9.5 10 9 9.2 

1 การ 

ยกยอง 

Super 

team 

Super 

team 

Great 

team 

Super 

team 

Super 

team 

Great 

team 

Super 

team 

Super 

team 

X  7.5 8.5 8 8.5 8.5 7.5 8.5 8.1 

2 การ 

ยกยอง 

Good 

team 

Great 

team 

Great 

team 

Great 

team 

Great 

team 

Good 

team 

Great 

team 

Great 

team 

X  8 9 10 8.5 9.5 10 8.5 9.1 

3 การ 

ยกยอง 

Great 

team 

Super 

team 

Super 

team 

Great 

team 

Super 

team 

Super 

team 

Great 

team 

Super 

team 

X  8 9 8.5 9 8 8.5 9 8.6 

4 การ 

ยกยอง 

Great 

team 

Super 

team 

Great 

team 

Super 

team 

Great 

team 

Great 

team 

Super 

team 

Great 

team 

X  8.5 9 9 8.5 9 8.5 9 8.8 

5 การ 

ยกยอง 

Great 

team 

Super 

team 

Super 

team 

Great 

team 

Super 

team 

Great 

team 

Super 

team 

Great 

team 

X  10 10 8.5 9.5 9.5 9 9 9.4 

6 การ 

ยกยอง 

Super 

team 

Super 

team 

Great 

team 

Super 

team 

Super 

team 

Super 

team 

Super 

team 

Super 

team 

X  10 8 10 9 9.5 8.5 9 9.1 

7 การ 

ยกยอง 

Super 

team 

Great 

team 

Super 

team 

Super 

team 

Super 

team 

Great 

team 

Super 

team 

Super 

team 
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ตาราง  16 (ตอ)   

 

กลุมที ่
 บทที ่

1 
บทที ่

2 
บทที ่

3 
บทที ่

4 
บทที ่

5 
บทที ่

6 
บทที ่

7 
สรุป 

X  8.5 8 9.5 8.5 9 9 9.5 8.9 

8 การ 

ยกยอง 

Great 

team 

Great 

team 

Super 

team 

Great 

team 

Super 

team 

Super 

team 

Super 

team 

Great 

team 

X  9 8 9.5 8.5 9.5 8.5 9.5 8.9 

9 การ 

ยกยอง 

Super 

team 

Great 

team 

Super 

team 

Great 

team 

Super 

team 

Great 

team 

Super 

team 

Great 

team 
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ภาคผนวก  จ 
 

แผนการจัดการเรียนรูและคูมือการใชงาน 
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แผนการจัดการเรียนรูที่  1 
กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี          สาระเพิ่มเติม 
รายวชิา คอมพิวเตอรมัลติมีเดีย (ง31242)             ชัน้มัธยมศึกษาปที4่ 
หนวยที ่1 เรื่อง รูจักกับโปรแกรม Flash 8              เวลา 2 คาบ 
****************************************************************************************************** 
สาระสําคัญ 

ในปจจุบันคอมพิวเตอรเปนส่ิงสําคัญในการเรียนรูสําหรับนักเรียน เพื่อใหนักเรียนมีความรู

และมีศักยภาพในการใชคอมพิวเตอรในการสรางสรรคผลงานตาง ๆ โปรแกรม Flash เปนอีก

โปรแกรมหน่ึงที่จะชวยใหนักเรียนมีศักยภาพ ในการสรางสรรคผลงานไดมากข้ึน ซึ่งโปรแกรมFlash 

เปนโปรแกรมที่ใชสําหรับสรางภาพเคล่ือนไหว (Animation) เชนการสรางเกม การสรางการตูน

เคล่ือนไหว (Animation) การสรางเว็บไซตเปนตน 
ผลการเรียนรู 

1. อธิบายลักษณะโครงสรางและสวนประกอบของโปรแกรม Flash  ได 

2. สามารถใชเคร่ืองมือ , องคประกอบตาง ๆ ของโปรแกรม Flash ในการสราง

ภาพเคลื่อนไหวข้ันพื้นฐานได 
สาระการเรียนรู 

1. คุณลักษณะของโปรแกรม Flash 

2. การเรียกใชโปรแกรม Flash 

3. สวนประกอบของโปรแกรม Flash 

4. เคร่ืองมือทีใ่ชในการสรางสรรคผลงานของโปรแกรม Flash 
กิจกรรมการเรียนรู 

ขั้นนําเสนอเนื้อหาตอทั้งชั้น 
1. ครูแจงผลการเรียนรูและสนทนากับนักเรียน  เร่ืองขอตกลงในการปฏิบัติตนในการเรียน

การสอนแบบมีสวนรวม  เทคนิค  TGT  โดยใหนักเรียนรูสึกเสมอวาการเรียนรูตอไปนี้เต็มไปดวย

บรรยากาศรวมมือกัน  เพื่อผลงานของกลุม  ทุกคนจะปฏิบัติหนาที่อยางเต็มใจ  เต็มเวลาและเต็ม

ประสิทธิภาพของตนเอง  ครูเปนผูสังเกตพฤติกรรมของนักเรียนตลอดเวลา 

2. ครูแนะนําบทเรียนบนเครือขายตามตามรูปแบบการเรียนรูแบบรวมมือ เทคนิค  TGT  

เร่ือง คอมพิวเตอรมัลติมีเดีย  เพื่อใหนักเรียนเขาศึกษาบทเรียนตามเมนู  โดยใหนักเรียนอานคํา

ชี้แจงในการใชบทเรียนใหเขาใจ 
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3. ครูใหนักเรียนทําแบบทดสอบกอนเรียน  กอนเขาสูบทเรียนเพื่อประเมินพื้นฐานความรู  

โดยใหทําเปนรายเด่ียวและใชเวลาประมาณ  30  นาที 
ขั้นการเรียนกลุมยอย  
1. ครูแบงนักเรียนออกเปน  9  กลุม  กลุมละ  4  คน  โดยคละเพศและความสามารถ  โดย

ดูจากผลการเรียนของนักเรียนในเทอมที่ผานมา 

2. ครูใหนักเรียนลงทะเบียนโดยใสกลุมตามที่ครูกําหนด  

3. ครูใหนักเรียนเขาสูระบบล็อกอินเพื่อเขาศึกษาบทเรียนบนเครือขาย  เร่ือง  คอมพิวเตอร

มัลติมีเดีย 

4. ครูใหนักเรียนแยกกลุมยอยศึกษาบทเรียนหนวยที่  1  เร่ือง รูจักกับโปรแกรม Flash 8  

ซึ่งประกอบดวยเนื้อหา  ดังนี้  คุณลักษณะของโปรแกรม Flash  การเรียกใชโปรแกรม Flash  

สวนประกอบของโปรแกรม Flash  เคร่ืองมือที่ใชในการสรางสรรคผลงานของโปรแกรม Flash  โดย

ใชการสนทนาผาน  Chat  room  ของแตละกลุม 

5. นักเรียนแตละกลุมทําใบงานกิจกรรมหนวยที่  1  จากเมนูกิจกรรมกลุม  โดยใหนักเรียน

แตละกลุมเขาไปสนทนาและตอบคําถามผานทางเว็บบอรดของกลุม  เมื่อไดคําตอบที่สมบูรณให

หัวหนากลุมสงคําตอบมาหาครูผานทางอีเมลลของครูผูสอน 

6. ครูติดตามการปฏิบัติงานกลุม  และปรับปรุงแกไขพฤติกรรมที่ไมเหมาะสมที่เกิดข้ึนใน

กระบวนการกลุม 
ขั้นการเลนเกมแขงขันทางวิชาการ 
1. ครูใหนักเรียนแขงขันตอบคําถามเกี่ยวกับเนื้อหาของบทเรียน  เกมประกอบดวยผูเลน   

3 – 6  คน  ซึ่งแตละคนจะเปนตัวแทนของกลุมยอยแตละกลุม  โดยยึดหลักนักเรียนที่มี

ความสามารถเทาเทียมกันแขงขันกัน  โดยนักเรียนทุกคนเขาโตะเกม  ซึ่งนักเรียนเกงของแตละกลุม

แขงขัน  นักเรียนปานกลางแขงขันกันและนักเรียนออนแขงขันกันในโตะเกมที่จัดไวใหเพื่อใหผูเรียน

ที่มีความสามารถใกลเคียงกันแขงขันกัน 
ขั้นทดสอบยอย 
1. ครูทดสอบความรู  ความเขาใจของนักเรียน โดยใหนักเรียนทําแบบทดสอบยอยทาย

หนวยการเรียนที่  1  จากเมนู  เปนรายบุคคล  โดยนักเรียนแตละคนไมมีการชวยเหลือกัน 
ขั้นรายงานคะแนนความกาวหนา 
1. ครูนําคะแนนสอบของนักเรียนแตละคน  มาเปรียบเทียบเพื่อหาคะแนนความกาวหนา

ของแตละคน  และรายงานผลคะแนนผานทางเว็บไซต  
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2. ครูนําคะแนนของนักเรียนแตละคนมารวมกันเพื่อหาคะแนนความกาวหนาของกลุมที่มี

คะแนนสูงสุดมาเทียบกับเกณฑเพื่อมอบรางวัลแกกลุม 

3. นักเรียนเขาไปดูรายงานคะแนนความกาวหนาของตนเองและกลุมบนเว็บไซต   

4. ครูและนักเรียนรวมกันสรุปความรูรวมกันและใหนักเรียนซักถามขอสงสัยเพิ่มเติมผาน

ทางเว็บบอรด 
ขั้นยกยองใหรางวลัแกกลุมที่มีความกาวหนา 
1. นักเรียนกลุมที่มีคะแนนกลุมดีที่สุดไดรับรางวัล  และประกาศบนเวบ็บอรดของบทเรียน 

สื่อและแหลงการเรียนรู 
1. ประเภทสือ่ 
- บทเรียนบนเครือขาย  เร่ือง  คอมพวิเตอรมัลติมีเดีย 

- เอกสารประกอบการเรียนการสอนหนวยที ่1 

- ใบงานท่ี 1.1 และ ใบงานที ่1.2 
2. วสัดุ/อุปกรณ 
- Projector 

- เคร่ืองคอมพวิเตอร 

- โปรแกรม Macromedia Flash 8 
3. แหลงเรียนรู 
- ครู 

- อินเทอรเน็ต 

- หองสมุด 
กระบวนการวัดและประเมินผล 

ดานพฤติกรรม ประเมินจากบันทึกการสังเกต 
1. ความต้ังใจเรียน  การมีสวนรวมในการเรียนการสอนและการทาํงานกลุม 

2. ความสนใจและการปฏิบัติตามขอตกลงรวมกนั 
ดานทักษะ ประเมินจากการบันทกึการสังเกต 
1. การใชอุปกรณคอมพิวเตอรไดอยางคลองแคลว 

2. การใชงานจากสวนตาง ๆ ของโปรแกรมได 
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 ดานความรู ประเมินจาก 
1. การตอบคําถามจากเนื้อหาที่เรียน 

2. ผลการปฏิบัติงานของนกัเรียน  จากการตรวจใบงานและแบบทดสอบหลังเรียนแตละ

หนวย 
คุณธรรม  จริยธรรมที่สอดแทรก 
 1. มีจรรยาบรรณในการใชเครือขายคอมพิวเตอรและอินเทอรเน็ต 

 2. มีจิตสํานึกในการใชงานอินเทอรเน็ตอยางสรางสรรค 

 3. มีทักษะในการทาํงานเปนทีม 
เครื่องมือที่ใช 

1. แบบประเมินสังเกตพฤติกรรมนักเรียน 

2. ใบงานที ่1.1 

3. ใบงานที ่1.2 

4. แบบทดสอบหลังเรียนประจําหนวย 
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แผนการจัดการเรียนรูที่  2 
กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี           สาระเพิ่มเติม 
รายวชิา คอมพิวเตอรมัลติมีเดีย (ง31242)              ชั้นมัธยมศึกษาปที่4 
หนวยที ่2 เรื่อง การใชเครื่องมือในการวาดภาพและการใชส ี            เวลา 2 คาบ 
****************************************************************************************************** 
สาระสําคัญ 

ในการสรางผลงานดวยโปรแกรม Flash 8 เปนความจําเปนที่จะตองมีความรูในการใช

เคร่ืองมือที่อยูในกลองเคร่ืองมือ (Tools) อยางถูกตองและถูกวิธี เพื่อใหสามารถเลือกใชเคร่ืองมอืได

อยางเหมาะสมกับการทํางานและใหไดผลงานที่ตรงตามความตองการ และมีประสิทธิภาพมาก

ที่สุดในการสรางสรรคผลงาน การใชสีก็มีความจําเปน ซึ่งสีจะเปนตัวทําใหผลงานมีจุดเดนและ

สะดุดตามากข้ึน 
ผลการเรียนรู 

1. อธิบายคุณสมบัติของเคร่ืองมือแตละชนิดในกลองเคร่ืองมือได 

2. สามารถใชเคร่ืองมือแตละชนิดไดอยางถูกวิธี และเหมาะสมกับการทํางาน 
สาระการเรียนรู 

1. เคร่ืองมือตาง ๆ ในกลองเคร่ืองมือ 

2. การใชเคร่ืองมือวาดภาพและกําหนดสี 
กิจกรรมการเรียนรู 

ขั้นนําเสนอเนื้อหาตอทั้งชั้น 
1. ครูแจงผลการเรียนรู 

2. ครูทบทวนความรูเดิมของนักเรียน  โดยใหนักเรียนเขาสูโปรแกรม  Flash 8  และให

นักเรียนรวมกันบอกองคประกอบของโปรแกรม 

3. ครูนําเสนอเนื้อหาและสาธิต  เร่ือง  การใชเคร่ืองมือในการวาดภาพและการใชสี  ซึ่ง

ประกอบดวยเนื้อหา  ดังนี้  เคร่ืองมือตาง ๆ ในกลองเคร่ืองมือ  การใชเคร่ืองมือวาดภาพและ

กําหนดสี 
ขั้นการเรียนกลุมยอย  
1. นักเรียนล็อกอินเขาสูระบบตามช่ือผูใชของตนเอง 

2. นักเรียนเขาไปดูความกาวหนาของตนเองและกลุมเพื่อเพิ่มแรงเสริมในการเรียนรู 

3. ครูใหนักเรียนแยกกลุมศึกษาบทเรียนจากเมนูเนื้อหาหนวยการเรียนที่  2   
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4. นักเรียนแตละกลุมทําใบงานกิจกรรมหนวยที่  2  จากเมนูกิจกรรมกลุม  โดยใหนักเรียน

แตละกลุมเขาไปสนทนาและตอบคําถามผานทางเว็บบอรดของกลุม  เมื่อไดคําตอบที่สมบูรณให

หัวหนากลุมสงคําตอบมาหาครูผานทางอีเมลลของครูผูสอน 

5. ครูติดตามการปฏิบัติงานกลุม  และปรับปรุงแกไขพฤติกรรมที่ไมเหมาะสมที่เกิดข้ึนใน

กระบวนการกลุม 
ขั้นการเลนเกมแขงขันทางวิชาการ 
1. ครูใหนักเรียนแขงขันตอบคําถามเกี่ยวกับเนื้อหาของบทเรียน   
ขั้นทดสอบยอย 
1. ครูทดสอบความรู  ความเขาใจของนักเรียน โดยใหนักเรียนทําแบบทดสอบยอยทาย

หนวยการเรียนที่  2  จากเมนู  เปนรายบุคคล  โดยนักเรียนแตละคนไมมีการชวยเหลือกัน 
ขั้นรายงานคะแนนความกาวหนา 
1. ครูนําคะแนนสอบของนักเรียนแตละคน  มาเปรียบเทียบเพื่อหาคะแนนความกาวหนา

ของแตละคน  และรายงานผลคะแนนผานทางเว็บไซต  

2. ครูนําคะแนนของนักเรียนแตละคนมารวมกันเพื่อหาคะแนนความกาวหนาของกลุมที่มี

คะแนนสูงสุดมาเทียบกับเกณฑเพื่อมอบรางวัลแกกลุม 

3. นักเรียนเขาไปดูรายงานคะแนนความกาวหนาของตนเองและกลุมบนเว็บไซต   

4. ครูและนักเรียนรวมกันสรุปความรูรวมกันและใหนักเรียนซักถามขอสงสัยเพิ่มเติมผาน

ทางเว็บบอรด 
ขั้นยกยองใหรางวัลแกกลุมที่มีความกาวหนา 
1. นักเรียนกลุมที่มีคะแนนกลุมดีที่สุดไดรับรางวัล  และประกาศบนเว็บบอรดของบทเรียน 

สื่อและแหลงการเรียนรู 
1. ประเภทสื่อ 
- บทเรียนบนเครือขาย  เร่ือง  คอมพิวเตอรมัลติมีเดีย 

- เอกสารประกอบการเรียนการสอนหนวยที่ 2 

- ใบงานที่ 2 และ ใบงานที่ 3 
2. วัสดุ/อุปกรณ 
- Projector 

- เคร่ืองคอมพวิเตอร 

- โปรแกรม Macromedia Flash 8 
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3. แหลงเรียนรู 
- ครู 

- อินเทอรเน็ต 

- หองสมุด 
กระบวนการวัดและประเมินผล 

ดานพฤติกรรม ประเมินจากบันทึกการสังเกต 
1. ความต้ังใจเรียน  การมีสวนรวมในการเรียนการสอนและการทาํงานกลุม 

2. ความสนใจและการปฏิบัติตามขอตกลงรวมกนั 
ดานทักษะ ประเมินจากการบันทกึการสังเกต 
1. การใชอุปกรณคอมพิวเตอรไดอยางคลองแคลว 

2. การใชงานจากสวนตาง ๆ ของโปรแกรมได 
 ดานความรู ประเมินจาก 

1. การตอบคําถามจากเนื้อหาที่เรียน 

2. ผลการปฏิบัติงานของนกัเรียน  จากการตรวจใบงานและแบบทดสอบหลังเรียนแตละ    

    หนวย 
คุณธรรม  จริยธรรมที่สอดแทรก 
 1. มีจรรยาบรรณในการใชเครือขายคอมพิวเตอรและอินเทอรเน็ต 

 2. มีจิตสํานึกในการใชงานอินเทอรเน็ตอยางสรางสรรค 

 3. มีทักษะในการทาํงานเปนทีม 
เครื่องมือที่ใช 

1. แบบประเมินสังเกตพฤติกรรมนักเรียน 

2. ใบงานที ่2 

3. ใบงานที ่3 

4. แบบทดสอบหลังเรียนประจําหนวย 
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แผนการจัดการเรียนรูที่  3 
กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี                    สาระเพิ่มเติม 
รายวชิา คอมพิวเตอรมัลติมีเดีย (ง31242)              ชั้นมัธยมศึกษาปที่4 
หนวยที ่3 เรื่อง การสรางภาพเคลื่อนไหวแบบ Frame by Frame           เวลา 2 คาบ 
****************************************************************************************************** 
สาระสําคัญ 

สมัยเด็ก ๆ หลายคนคงจะเคยเขียนรูปการตูน หรือ รูปคนกําลังเดิน หรือทําทาทางตาง ๆ 

กันไวที่มุมของหนังสือแตละหนา แลวก็ทําการกรีดที่มุมของหนังสือ เราก็จะเห็นภาพที่เราวาดเปน

ภาพเคลื่อนไหว ลักษณะแบบนี้เองที่เรียกวา การเคลื่อนไหวแบบ Frame by Frame คือทุก ๆ ภาพ

การเคลื่อนไหวมาจากการเปลี่ยนภาพไปทุก ๆ ภาพ แสดงใหเห็นแบบ Frame by frameนั่นเอง 
ผลการเรียนรู 

1. อธิบายหลักการทํางานของการเคล่ือนไหวและลักษณะของการเคล่ือนไหวแบบเฟรมตอ

เฟรม ได 

2. สามารถกําหนดและควบคุมลําดับการทํางานของการเคล่ือนไหวดวยฉากได 

3. สามารถสรางงานที่มีการเคล่ือนไหวแบบเฟรมตอเฟรมดวยโปรแกรม Flash ได 
สาระการเรียนรู 

1. ความรูพื้นฐานของการสรางภาพเคลื่อนไหว 

2. การกําหนดและควบคุมลําดับการทํางานของการเคล่ือนไหวดวย Scene  

3. ความหมาย  ข้ันตอนและเทคนิคการสรางภาพเคลื่อนไหว แบบ Frame by Frame  
กิจกรรมการเรียนรู 

ขั้นนําเสนอเนื้อหาตอทั้งชั้น 
1. ครูแจงผลการเรียนรู 

2. ครูทบทวนความรูเดิมของนักเรียน  โดยใหนักเรียนบอกเครื่องมือในการวาดภาพและ

การใชสี 

3. ครูนําเสนอเนื้อหาและสาธิต  เร่ือง  การสรางภาพเคลื่อนไหว แบบ Frame by Frame 

ซึ่งประกอบดวยเนื้อหา  ดังนี้  ความรูพื้นฐานของการสรางภาพเคลื่อนไหว  การกําหนดและควบคุม

ลําดับการทํางานของการเคล่ือนไหวดวย Scene  ความหมาย  ข้ันตอนและเทคนิคการสราง

ภาพเคลื่อนไหว แบบ Frame by Frame  
ขั้นการเรียนกลุมยอย  
1. นักเรียนล็อกอินเขาสูระบบตามช่ือผูใชของตนเอง 
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2. ครูใหนักเรียนแยกกลุมศึกษาบทเรียนจากเมนูเนื้อหาหนวยการเรียนที่  3   

3. นักเรียนแตละกลุมทําใบงานกิจกรรมหนวยที่  3  จากเมนูกิจกรรมกลุม  โดยใหนักเรียน

แตละกลุมเขาไปสนทนาและตอบคําถามผานทางเว็บบอรดของกลุม  เมื่อไดคําตอบที่สมบูรณให

หัวหนากลุมสงคําตอบมาหาครูผานทางอีเมลลของครูผูสอน 

4. ครูติดตามการปฏิบัติงานกลุม  และปรับปรุงแกไขพฤติกรรมที่ไมเหมาะสมที่เกิดข้ึนใน

กระบวนการกลุม 
ขั้นการเลนเกมแขงขันทางวิชาการ 
1. ครูใหนักเรียนแขงขันตอบคําถามเกี่ยวกับเนื้อหาของบทเรียน   
ขั้นทดสอบยอย 
1. ครูทดสอบความรู  ความเขาใจของนักเรียน โดยใหนักเรียนทําแบบทดสอบยอยทาย

หนวยการเรียนที่  3  จากเมนู  เปนรายบุคคล  โดยนักเรียนแตละคนไมมีการชวยเหลือกัน 
ขั้นรายงานคะแนนความกาวหนา 
1. ครูนําคะแนนสอบของนักเรียนแตละคน  มาเปรียบเทียบเพื่อหาคะแนนความกาวหนา

ของแตละคน  และรายงานผลคะแนนผานทางเว็บไซต  

2. ครูนําคะแนนของนักเรียนแตละคนมารวมกันเพื่อหาคะแนนความกาวหนาของกลุมที่มี

คะแนนสูงสุดมาเทียบกับเกณฑเพื่อมอบรางวัลแกกลุม 

3. นักเรียนเขาไปดูรายงานคะแนนความกาวหนาของตนเองและกลุมบนเว็บไซต   

4. ครูและนักเรียนรวมกันสรุปความรูรวมกันและใหนักเรียนซักถามขอสงสัยเพิ่มเติมผาน

ทางเว็บบอรด 
ขั้นยกยองใหรางวลัแกกลุมที่มีความกาวหนา 
1. นักเรียนกลุมที่มีคะแนนกลุมดีที่สุดไดรับรางวัล  และประกาศบนเวบ็บอรดของบทเรียน 

สื่อและแหลงการเรียนรู 
1. ประเภทสือ่ 
- บทเรียนบนเครือขาย  เร่ือง  คอมพวิเตอรมัลติมีเดีย 

- เอกสารประกอบการเรียนการสอนหนวยที ่3 

- ใบงานท่ี 4 
2. วสัดุ/อุปกรณ 
- Projector 

- เคร่ืองคอมพวิเตอร 

- โปรแกรม Macromedia Flash 8 
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3. แหลงเรียนรู 
- ครู 

- อินเทอรเน็ต 

- หองสมุด 
กระบวนการวัดและประเมินผล 

ดานพฤติกรรม ประเมินจากบันทึกการสังเกต 
1. ความต้ังใจเรียน  การมีสวนรวมในการเรียนการสอนและการทาํงานกลุม 

2. ความสนใจและการปฏิบัติตามขอตกลงรวมกนั 
ดานทักษะ ประเมินจากการบันทกึการสังเกต 
1. การใชอุปกรณคอมพิวเตอรไดอยางคลองแคลว 

2. การใชงานจากสวนตาง ๆ ของโปรแกรมได 
 ดานความรู ประเมินจาก 

1. การตอบคําถามจากเนื้อหาที่เรียน 

2. ผลการปฏิบัติงานของนกัเรียน  จากการตรวจใบงานและแบบทดสอบหลังเรียนแตละ

หนวย 
คุณธรรม  จริยธรรมที่สอดแทรก 
 1. มีจรรยาบรรณในการใชเครือขายคอมพิวเตอรและอินเทอรเน็ต 

 2. มีจิตสํานึกในการใชงานอินเทอรเน็ตอยางสรางสรรค 

 3. มีทักษะในการทาํงานเปนทีม 
เครื่องมือที่ใช 

1. แบบประเมินสังเกตพฤติกรรมนักเรียน 

2. ใบงานที ่4 

3. แบบทดสอบหลังเรียนประจําหนวย 
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แผนการจัดการเรียนรูที่  4 
กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี           สาระเพิ่มเติม 
รายวชิา คอมพิวเตอรมัลติมีเดีย (ง31242)              ชั้นมัธยมศึกษาปที่4 
หนวยที ่4 เรื่อง การสรางภาพเคลื่อนไหว แบบ Motion Tween              เวลา 2 คาบ 
****************************************************************************************************** 
สาระสําคัญ 

การสรางภาพเคลื่อนไหวแบบ Motion Tween เปนการสรางภาพเคลื่อนไหว ชนิดกําหนด

จุด เร่ิมตนและจุดส้ินสุด การสรางภาพเคลื่อนไหว แบบ Motion Tween นี้ เหมาะสําหรับการสราง

ภาพ เคล่ือนไหวแบบที่ตองการความตอเนื่องสม่ําเสมอ 
ผลการเรียนรู 

1. อธิบายหลักการสรางภาพเคลื่อนไหวแบบเปล่ียนแปลงตําแหนงได 

2. สามารถสรางภาพเคลื่อนไหวแบบเปล่ียนแปลงตําแหนงดวยโปรแกรม Flash ได 
สาระการเรียนรู 

1. การสรางภาพเคลื่อนไหวแบบ  Tween 

2. การสรางภาพเคลื่อนไหวแบบ  Motion Tween  
กิจกรรมการเรียนรู 

ขั้นนําเสนอเนื้อหาตอทั้งชั้น 
1. ครูแจงผลการเรียนรู 

2. ครูทบทวนความรูเดิมของนักเรียน  โดยใหนักเรียนชวยกันอธิบายหลักการทํางานของ

การเคลื่อนไหวและลักษณะของการเคล่ือนไหวแบบเฟรมตอเฟรม 

3. ครูนําเสนอเนื้อหาและสาธิต  เร่ือง  การสรางภาพเคลื่อนไหวแบบ  Motion Tween  ซึ่ง

ประกอบดวยเนื้อหา  ดังนี้  การสรางภาพเคลื่อนไหวแบบ  Tween  การสรางภาพเคลื่อนไหวแบบ  

Motion Tween  
ขั้นการเรียนกลุมยอย  
1. นักเรียนล็อกอินเขาสูระบบตามช่ือผูใชของตนเอง 

2. ครูใหนักเรียนแยกกลุมศึกษาบทเรียนจากเมนูเนื้อหาหนวยการเรียนที่  4   

3. นักเรียนแตละกลุมทําใบงานกิจกรรมหนวยที่  4  จากเมนูกิจกรรมกลุม  โดยใหนักเรียน

แตละกลุมเขาไปสนทนาและตอบคําถามผานทางเว็บบอรดของกลุม  เมื่อไดคําตอบที่สมบูรณให

หัวหนากลุมสงคําตอบมาหาครูผานทางอีเมลลของครูผูสอน 
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4. ครูติดตามการปฏิบัติงานกลุม  และปรับปรุงแกไขพฤติกรรมที่ไมเหมาะสมที่เกิดข้ึนใน

กระบวนการกลุม 
ขั้นการเลนเกมแขงขันทางวิชาการ 
1. ครูใหนักเรียนแขงขันตอบคําถามเกี่ยวกับเนื้อหาของบทเรียน   
ขั้นทดสอบยอย 
1. ครูทดสอบความรู  ความเขาใจของนักเรียน โดยใหนักเรียนทําแบบทดสอบยอยทาย

หนวยการเรียนที่  4  จากเมนู  เปนรายบุคคล  โดยนักเรียนแตละคนไมมีการชวยเหลือกัน 
ขั้นรายงานคะแนนความกาวหนา 
1. ครูนําคะแนนสอบของนักเรียนแตละคน  มาเปรียบเทียบเพื่อหาคะแนนความกาวหนา

ของแตละคน  และรายงานผลคะแนนผานทางเว็บไซต  

2. ครูนําคะแนนของนักเรียนแตละคนมารวมกันเพื่อหาคะแนนความกาวหนาของกลุมที่มี

คะแนนสูงสุดมาเทียบกับเกณฑเพื่อมอบรางวัลแกกลุม 

3. นักเรียนเขาไปดูรายงานคะแนนความกาวหนาของตนเองและกลุมบนเว็บไซต   

4. ครูและนักเรียนรวมกันสรุปความรูรวมกันและใหนักเรียนซักถามขอสงสัยเพิ่มเติมผาน

ทางเว็บบอรด 
ขั้นยกยองใหรางวลัแกกลุมที่มีความกาวหนา 
1. นักเรียนกลุมที่มีคะแนนกลุมดีที่สุดไดรับรางวัล  และประกาศบนเวบ็บอรดของบทเรียน 

สื่อและแหลงการเรียนรู 
1. ประเภทสือ่ 
- บทเรียนบนเครือขาย  เร่ือง  คอมพวิเตอรมัลติมีเดีย 

- เอกสารประกอบการเรียนการสอนหนวยที ่4 

- ใบงานท่ี 5 
2. วสัดุ/อุปกรณ 
- Projector 

- เคร่ืองคอมพวิเตอร 

- โปรแกรม Macromedia Flash 8 
3. แหลงเรียนรู 
- ครู 

- อินเทอรเน็ต 

- หองสมุด 
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กระบวนการวัดและประเมินผล 
ดานพฤติกรรม ประเมินจากบันทึกการสังเกต 
1. ความต้ังใจเรียน  การมีสวนรวมในการเรียนการสอนและการทาํงานกลุม 

2. ความสนใจและการปฏิบัติตามขอตกลงรวมกนั 
ดานทักษะ ประเมินจากการบันทกึการสังเกต 
1. การใชอุปกรณคอมพิวเตอรไดอยางคลองแคลว 

2. การใชงานจากสวนตาง ๆ ของโปรแกรมได 
 ดานความรู ประเมินจาก 

1. การตอบคําถามจากเนื้อหาที่เรียน 

2. ผลการปฏิบัติงานของนกัเรียน  จากการตรวจใบงานและแบบทดสอบหลังเรียนแตละ

หนวย 
คุณธรรม  จริยธรรมที่สอดแทรก 
 1. มีจรรยาบรรณในการใชเครือขายคอมพิวเตอรและอินเทอรเน็ต 

 2. มีจิตสํานึกในการใชงานอินเทอรเน็ตอยางสรางสรรค 

 3. มีทักษะในการทาํงานเปนทีม 
เครื่องมือที่ใช 

1. แบบประเมินสังเกตพฤติกรรมนักเรียน 

2. ใบงานที ่5 

3. แบบทดสอบหลังเรียนประจําหนวย 
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แผนการจัดการเรียนรูที่  5 
กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี                    สาระเพิ่มเติม 
รายวชิา คอมพิวเตอรมัลติมีเดีย (ง31242)              ชั้นมัธยมศึกษาปที่4 
หนวยที ่5 เรื่อง การสรางภาพเคลื่อนไหว แบบ Motion Guide Tween           เวลา 2 คาบ 
****************************************************************************************************** 
สาระสําคัญ 

การสรางภาพเคลื่อนไหว แบบ Motion Guide Tween หรือโดยใชGuideline หรือ Path 

นั้นเปนการสรางภาพภาพเคล่ือนไหว โดยใหวัตถุหรือภาพที่กําหนด เคล่ือนที่ไปตามเสนทางทีเ่ราได

กําหนดเอาไวโดยผาน Guideline ซึ่งชวยในการนําทาง ซึ่งนับวาเปนลูกเลนสําคัญอีกอยางหนึ่งใน

การสรางภาพเคลื่อนไหว ดวยโปรแกรม Flash ทั้งนี้Guide Motion สามารถนํามาประยุกตใชสราง

ภาพเคลื่อนไหวไดอีกหลายรูปแบบ 
ผลการเรียนรู 

1. อธิบายเกี่ยวกับข้ันตอนและหลักการในการสรางภาพเคลื่อนไหวโดยใหวัตถุหรือภาพที่

กําหนดเคล่ือนที่ไปตามเสนทางที่ไดกําหนดเอาไวไดอยางถูกตอง 

2. สามารถสรางภาพเคลื่อนไหวโดยใหวัตถุหรือภาพที่กําหนดเคล่ือนที่ไปตามเสนทางที่ได

กําหนดเอาไว ไดถูกตองและสวยงาม 
สาระการเรียนรู 

1. การสรางภาพเคลื่อนไหวแบบ Guide Motion  

2. เทคนิคในการสรางภาพเคลื่อนไหว แบบตาง ๆ 
กิจกรรมการเรียนรู 

ขั้นนําเสนอเนื้อหาตอทั้งชั้น 
1. ครูแจงผลการเรียนรู 

2. ครูทบทวนความรูเดิมของนักเรียน  โดยใหนักเรียนชวยกันอธิบายหลักการสราง

ภาพเคลื่อนไหวแบบเปล่ียนแปลงตําแหนง 

3. ครูนําเสนอเนื้อหาและสาธิต  เร่ือง  การสรางภาพเคล่ือนไหว แบบ Motion Guide 

Tween ซึ่งประกอบดวยเนื้อหา  ดังนี้  การสรางภาพเคลื่อนไหวแบบ Guide Motion  เทคนิคในการ

สรางภาพเคลื่อนไหว แบบตาง ๆ 
ขั้นการเรียนกลุมยอย  
1. นักเรียนล็อกอินเขาสูระบบตามช่ือผูใชของตนเอง 

2. ครูใหนักเรียนแยกกลุมศึกษาบทเรียนจากเมนูเนื้อหาหนวยการเรียนที่  5   
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3. นักเรียนแตละกลุมทําใบงานกิจกรรมหนวยที่  5  จากเมนูกิจกรรมกลุม  โดยใหนักเรียน

แตละกลุมเขาไปสนทนาและตอบคําถามผานทางเว็บบอรดของกลุม  เมื่อไดคําตอบที่สมบูรณให

หัวหนากลุมสงคําตอบมาหาครูผานทางอีเมลลของครูผูสอน 

4. ครูติดตามการปฏิบัติงานกลุม  และปรับปรุงแกไขพฤติกรรมที่ไมเหมาะสมที่เกิดข้ึนใน

กระบวนการกลุม 
ขั้นการเลนเกมแขงขันทางวิชาการ 
1. ครูใหนักเรียนแขงขันตอบคําถามเกี่ยวกับเนื้อหาของบทเรียน   
ขั้นทดสอบยอย 
1. ครูทดสอบความรู  ความเขาใจของนักเรียน โดยใหนักเรียนทําแบบทดสอบยอยทาย

หนวยการเรียนที่  5  จากเมนู  เปนรายบุคคล  โดยนักเรียนแตละคนไมมีการชวยเหลือกัน 
ขั้นรายงานคะแนนความกาวหนา 
1. ครูนําคะแนนสอบของนักเรียนแตละคน  มาเปรียบเทียบเพื่อหาคะแนนความกาวหนา

ของแตละคน  และรายงานผลคะแนนผานทางเว็บไซต  

2. ครูนําคะแนนของนักเรียนแตละคนมารวมกันเพื่อหาคะแนนความกาวหนาของกลุมที่มี

คะแนนสูงสุดมาเทียบกับเกณฑเพื่อมอบรางวัลแกกลุม 

3. นักเรียนเขาไปดูรายงานคะแนนความกาวหนาของตนเองและกลุมบนเว็บไซต   

4. ครูและนักเรียนรวมกันสรุปความรูรวมกันและใหนักเรียนซักถามขอสงสัยเพิ่มเติมผาน

ทางเว็บบอรด 
ขั้นยกยองใหรางวลัแกกลุมที่มีความกาวหนา 
1. นักเรียนกลุมที่มีคะแนนกลุมดีที่สุดไดรับรางวัล  และประกาศบนเวบ็บอรดของบทเรียน 

สื่อและแหลงการเรียนรู 
1. ประเภทสือ่ 
- บทเรียนบนเครือขาย  เร่ือง  คอมพวิเตอรมัลติมีเดีย 

- เอกสารประกอบการเรียนการสอนหนวยที ่5 

- ใบงานท่ี 6 
2. วสัดุ/อุปกรณ 
- Projector 

- เคร่ืองคอมพวิเตอร 

- โปรแกรม Macromedia Flash 8 
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3. แหลงเรียนรู 
- ครู 

- อินเทอรเน็ต 

- หองสมุด 
กระบวนการวัดและประเมินผล 

ดานพฤติกรรม ประเมินจากบันทึกการสังเกต 
1. ความต้ังใจเรียน  การมีสวนรวมในการเรียนการสอนและการทาํงานกลุม 

2. ความสนใจและการปฏิบัติตามขอตกลงรวมกนั 
ดานทักษะ ประเมินจากการบันทกึการสังเกต 
1. การใชอุปกรณคอมพิวเตอรไดอยางคลองแคลว 

2. การใชงานจากสวนตาง ๆ ของโปรแกรมได 
 ดานความรู ประเมินจาก 

1. การตอบคําถามจากเนื้อหาที่เรียน 

2. ผลการปฏิบัติงานของนกัเรียน  จากการตรวจใบงานและแบบทดสอบหลังเรียนแตละ

หนวย 
คุณธรรม  จริยธรรมที่สอดแทรก 
 1. มีจรรยาบรรณในการใชเครือขายคอมพิวเตอรและอินเทอรเน็ต 

 2. มีจิตสํานึกในการใชงานอินเทอรเน็ตอยางสรางสรรค 

 3. มีทักษะในการทาํงานเปนทีม 
เครื่องมือที่ใช 

1. แบบประเมินสังเกตพฤติกรรมนักเรียน 

2. ใบงานที ่6 

3. แบบทดสอบหลังเรียนประจําหนวย 
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แผนการจัดการเรียนรูที่  6 
กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี           สาระเพิ่มเติม 
รายวชิา คอมพิวเตอรมัลติมีเดีย (ง31242)              ชั้นมัธยมศึกษาปที่4 
หนวยที ่6 เรื่อง การใชงาน Layer Mask                เวลา 2 คาบ 
****************************************************************************************************** 
สาระสําคัญ 

การสราง Animation โดยใชLayer Mask ลักษณะนี้เปนการ Mask หรือทําการบัง Layer ที่

อยูตํ่ากวาไมใหถูกมองเห็น โดยจะใหขอบเขตของวัตถุที่อยูใน Layer Mask เปนเสมือนชองหรือ

หนาตางใหมองเห็นวัตถุที่อยูใตLayer Mask ไดเพียงบางสวน 
ผลการเรียนรู 

1. อธิบายวิธีการสรางและข้ันตอนการซอนเลเยอร ได 

2. สามารถสรางงานภาพเคล่ือนไหวแบบซอนเลเยอร ได 

3. สามารถนําวิธีการซอนเลเยอรไปประยุกตสรางงานภาพเคล่ือนไหว แบบตาง ๆ ได 
สาระการเรียนรู 

1. การทํางานของ Layer Mask 

2. การสราง Layer Mask 

3. การนําLayer Mask ไปประยุกตในการนําเสนอผลงาน การสรางภาพเคลื่อนไหวแบบ

ตาง ๆ 
กิจกรรมการเรียนรู 

ขั้นนําเสนอเนื้อหาตอทั้งชั้น 
1. ครูแจงผลการเรียนรู 

2. ครูทบทวนความรูเดิมของนักเรียน  โดยใหนักเรียนชวยกันอธิบายเกี่ยวกับข้ันตอนและ

หลักการในการสรางภาพเคล่ือนไหวโดยใหวัตถุหรือภาพที่กําหนดเคล่ือนที่ไปตามเสนทางที่ได

กําหนดเอาไว 

3. ครูนําเสนอเนื้อหาและสาธิต  เร่ือง  การใชงาน Layer Mask ซึ่งประกอบดวยเนื้อหา  

ดังนี้  การทํางานของ Layer Mask  การสราง Layer Mask  การนําLayer Mask ไปประยุกตในการ

นําเสนอผลงาน การสรางภาพเคลื่อนไหวแบบตาง ๆ 
ขั้นการเรียนกลุมยอย  
1. นักเรียนล็อกอินเขาสูระบบตามช่ือผูใชของตนเอง 

2. ครูใหนักเรียนแยกกลุมศึกษาบทเรียนจากเมนูเนื้อหาหนวยการเรียนที่  6   
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3. นักเรียนแตละกลุมทําใบงานกิจกรรมหนวยที่  6  จากเมนูกิจกรรมกลุม  โดยใหนักเรียน

แตละกลุมเขาไปสนทนาและตอบคําถามผานทางเว็บบอรดของกลุม  เมื่อไดคําตอบที่สมบูรณให

หัวหนากลุมสงคําตอบมาหาครูผานทางอีเมลลของครูผูสอน 

4. ครูติดตามการปฏิบัติงานกลุม  และปรับปรุงแกไขพฤติกรรมที่ไมเหมาะสมที่เกิดข้ึนใน

กระบวนการกลุม 
ขั้นการเลนเกมแขงขันทางวิชาการ 
1. ครูใหนักเรียนแขงขันตอบคําถามเกี่ยวกับเนื้อหาของบทเรียน   
ขั้นทดสอบยอย 
1. ครูทดสอบความรู  ความเขาใจของนักเรียน โดยใหนักเรียนทําแบบทดสอบยอยทาย

หนวยการเรียนที่  6  จากเมนู  เปนรายบุคคล  โดยนักเรียนแตละคนไมมีการชวยเหลือกัน 
ขั้นรายงานคะแนนความกาวหนา 
1. ครูนําคะแนนสอบของนักเรียนแตละคน  มาเปรียบเทียบเพื่อหาคะแนนความกาวหนา

ของแตละคน  และรายงานผลคะแนนผานทางเว็บไซต  

2. ครูนําคะแนนของนักเรียนแตละคนมารวมกันเพื่อหาคะแนนความกาวหนาของกลุมที่มี

คะแนนสูงสุดมาเทียบกับเกณฑเพื่อมอบรางวัลแกกลุม 

3. นักเรียนเขาไปดูรายงานคะแนนความกาวหนาของตนเองและกลุมบนเว็บไซต   

4. ครูและนักเรียนรวมกันสรุปความรูรวมกันและใหนักเรียนซักถามขอสงสัยเพิ่มเติมผาน

ทางเว็บบอรด 
ขั้นยกยองใหรางวลัแกกลุมที่มีความกาวหนา 
1. นักเรียนกลุมที่มีคะแนนกลุมดีที่สุดไดรับรางวัล  และประกาศบนเวบ็บอรดของบทเรียน 

สื่อและแหลงการเรียนรู 
1. ประเภทสือ่ 
- บทเรียนบนเครือขาย  เร่ือง  คอมพวิเตอรมัลติมีเดีย 

- เอกสารประกอบการเรียนการสอนหนวยที ่6 

- ใบงานท่ี 7 
2. วสัดุ/อุปกรณ 
- Projector 

- เคร่ืองคอมพวิเตอร 

- โปรแกรม Macromedia Flash 8 
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3. แหลงเรียนรู 
- ครู 

- อินเทอรเน็ต 

- หองสมุด 
กระบวนการวัดและประเมินผล 

ดานพฤติกรรม ประเมินจากบันทึกการสังเกต 
1. ความต้ังใจเรียน  การมีสวนรวมในการเรียนการสอนและการทาํงานกลุม 

2. ความสนใจและการปฏิบัติตามขอตกลงรวมกนั 
ดานทักษะ ประเมินจากการบันทกึการสังเกต 
1. การใชอุปกรณคอมพิวเตอรไดอยางคลองแคลว 

2. การใชงานจากสวนตาง ๆ ของโปรแกรมได 
 ดานความรู ประเมินจาก 

1. การตอบคําถามจากเนื้อหาที่เรียน 

2. ผลการปฏิบัติงานของนกัเรียน  จากการตรวจใบงานและแบบทดสอบหลังเรียนแตละ

หนวย 
คุณธรรม  จริยธรรมที่สอดแทรก 
 1. มีจรรยาบรรณในการใชเครือขายคอมพิวเตอรและอินเทอรเน็ต 

 2. มีจิตสํานึกในการใชงานอินเทอรเน็ตอยางสรางสรรค 

 3. มีทักษะในการทาํงานเปนทีม 
เครื่องมือที่ใช 

1. แบบประเมินสังเกตพฤติกรรมนักเรียน 

2. ใบงานที ่7 

3. แบบทดสอบหลังเรียนประจําหนวย 
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แผนการจัดการเรียนรูที่  7 
กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี           สาระเพิ่มเติม 
รายวชิา คอมพิวเตอรมัลติมีเดีย (ง31242)              ชั้นมัธยมศึกษาปที่4 
หนวยที ่7 เรื่อง การสรางตัวอักษรแบบคาราโอเกะ               เวลา 2 คาบ 
******************************************************************************************************
สาระสําคัญ 

ในการจัดทําโครงงานแอนิเมชัน มิวสิควิดีโอ นั้น เพื่อใหโครงงานนั้น มีความนาสนใจและมี

ลูกเลนหลากหลายมากข้ึน การใสเนื้อเพลงแบบคาราโอเกะ ก็เปนอีกส่ิงหนึ่งที่เพิ่มความนาสนใจ

ใหกับชิ้นงานไดไมนอย ซึ่งการใสเนื้อเพลงแบบคาราโอเกะนี้ ยังสามารถนําไปประยุกตใชกับงาน

อ่ืนๆ ไดอีกมากมาย เชน การทํานิทาน การทําโฆษณา หรือ ใชในการตกแตงเว็บไซตใหมีลูกเลน

สะดุดตามากยิ่งข้ึน 
ผลการเรียนรู 

1. อธิบายลักษณะและหลักการทํางานของตัวอักษรแบบคาราโอเกะได 

2. สามารถสรางการเคล่ือนไหวของตัวอักษรแบบคาราโอเกะ และนําไปประยุกตใชกับชิ้นงาน

ของตนเองได 
สาระการเรียนรู 

1. การเคลื่อนไหวของตัวอักษรแบบคาราโอเกะ 

2. หลักการทํางานของตัวอักษรแบบคาราโอเกะ 

3. การสรางการเคลื่อนไหวของตัวอักษรแบบคาราโอเกะ 
กิจกรรมการเรียนรู 

ขั้นนําเสนอเนื้อหาตอทั้งชั้น 
1. ครูแจงผลการเรียนรู 

2. ครูทบทวนความรูเดิมของนักเรียน  โดยใหนักเรียนชวยกันอธิบายวิธีการสรางและ

ขั้นตอนการซอนเลเยอร  

3. ครูนําเสนอเนื้อหาและสาธิต  เร่ือง  การสรางตัวอักษรแบบคาราโอเกะ  ซึ่งประกอบดวย

เนื้อหา  ดังนี้  การสรางภาพเคลื่อนไหวแบบ  Tween  การสรางภาพเคลื่อนไหวแบบ  Motion 

Tween  
ขั้นการเรียนกลุมยอย  
1. นักเรียนล็อกอินเขาสูระบบตามช่ือผูใชของตนเอง 

2. ครูใหนักเรียนแยกกลุมศึกษาบทเรียนจากเมนูเนื้อหาหนวยการเรียนที ่ 7   
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3. นักเรียนแตละกลุมทําใบงานกิจกรรมหนวยที่  7  จากเมนูกิจกรรมกลุม  โดยใหนักเรียน

แตละกลุมเขาไปสนทนาและตอบคําถามผานทางเว็บบอรดของกลุม  เมื่อไดคําตอบที่สมบูรณให

หัวหนากลุมสงคําตอบมาหาครูผานทางอีเมลลของครูผูสอน 

4. ครูติดตามการปฏิบัติงานกลุม  และปรับปรุงแกไขพฤติกรรมที่ไมเหมาะสมที่เกิดข้ึนใน

กระบวนการกลุม 
ขั้นการเลนเกมแขงขันทางวิชาการ 
1. ครูใหนักเรียนแขงขันตอบคําถามเกี่ยวกับเนื้อหาของบทเรียน   
ขั้นทดสอบยอย 
1. ครูทดสอบความรู  ความเขาใจของนักเรียน โดยใหนักเรียนทําแบบทดสอบยอยทาย

หนวยการเรียนที่  7  จากเมนู  เปนรายบุคคล  โดยนักเรียนแตละคนไมมีการชวยเหลือกัน 
ขั้นรายงานคะแนนความกาวหนา 
1. ครูนําคะแนนสอบของนักเรียนแตละคน  มาเปรียบเทียบเพื่อหาคะแนนความกาวหนา

ของแตละคน  และรายงานผลคะแนนผานทางเว็บไซต  

2. ครูนําคะแนนของนักเรียนแตละคนมารวมกันเพื่อหาคะแนนความกาวหนาของกลุมที่มี

คะแนนสูงสุดมาเทียบกับเกณฑเพื่อมอบรางวัลแกกลุม 

3. นักเรียนเขาไปดูรายงานคะแนนความกาวหนาของตนเองและกลุมบนเว็บไซต   

4. ครูและนักเรียนรวมกันสรุปความรูรวมกันและใหนักเรียนซักถามขอสงสัยเพิ่มเติมผาน

ทางเว็บบอรด 
ขั้นยกยองใหรางวลัแกกลุมที่มีความกาวหนา 
1. นักเรียนกลุมที่มีคะแนนกลุมดีที่สุดไดรับรางวัล  และประกาศบนเวบ็บอรดของบทเรียน 

สื่อและแหลงการเรียนรู 
1. ประเภทสือ่ 
- บทเรียนบนเครือขาย  เร่ือง  คอมพวิเตอรมัลติมีเดีย 

- เอกสารประกอบการเรียนการสอนหนวยที ่7 

- ใบงานท่ี 8 
2. วสัดุ/อุปกรณ 
- Projector 

- เคร่ืองคอมพวิเตอร 

- โปรแกรม Macromedia Flash 8 
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3. แหลงเรียนรู 
- ครู 

- อินเทอรเน็ต 

- หองสมุด 
กระบวนการวัดและประเมินผล 

ดานพฤติกรรม ประเมินจากบันทึกการสังเกต 
1. ความต้ังใจเรียน  การมีสวนรวมในการเรียนการสอนและการทาํงานกลุม 

2. ความสนใจและการปฏิบัติตามขอตกลงรวมกนั 
ดานทักษะ ประเมินจากการบันทกึการสังเกต 
1. การใชอุปกรณคอมพิวเตอรไดอยางคลองแคลว 

2. การใชงานจากสวนตาง ๆ ของโปรแกรมได 
 ดานความรู ประเมินจาก 

1. การตอบคําถามจากเนื้อหาที่เรียน 

2. ผลการปฏิบัติงานของนกัเรียน  จากการตรวจใบงานและแบบทดสอบหลังเรียนแตละ

หนวย 
คุณธรรม  จริยธรรมที่สอดแทรก 
 1. มีจรรยาบรรณในการใชเครือขายคอมพิวเตอรและอินเทอรเน็ต 

 2. มีจิตสํานึกในการใชงานอินเทอรเน็ตอยางสรางสรรค 

 3. มีทักษะในการทาํงานเปนทีม 
เครื่องมือที่ใช 

1. แบบประเมินสังเกตพฤติกรรมนักเรียน 

2. ใบงานที ่8 

3. แบบทดสอบหลังเรียนประจําหนวย 
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คูมือการใชบทเรียนบนเครือขายตามรปูแบบการเรยีนรูแบบรวมมือเทคนิค  TGT  เรื่อง  
คอมพิวเตอรมัลติมีเดีย  สําหรบันักเรยีนชั้นมัธยมศึกษาปที่  4 

 
บทเรียนบนเครือขาย  (Web-base  Instruction)  คือ  การใชเทคโนโลยีอินเทอรเน็ตในการ

เรียนการสอน  โดยผูเรียนสามารถติดตอส่ือสารกับผูเรียนดวยกันและครูผูสอนไดอยางไมจํากัด

เวลา  ไมจํากัดสถานที่ภายใตระบบเครือขาย 

ในการศึกษาจากบทเรียนบนเครือขายตามรูปแบบการเรียนรูแบบรวมมือเทคนิค  TGT  

เร่ือง  คอมพิวเตอรมัลติมีเดีย  สําหรับนักเรียนช้ันมัธยมศึกษาปที่  4  จะตองปฏิบัติตามข้ันตอน

ตอไปนี้ 

 

1.  เขาสูบทเรียนที่  http://202.143.173.236/users/wbiflash/ 

 

 
 
ภาพ  5  แสดงหนาโฮมเพจ (Home Page)  บทเรยีนบนเครือขายตามรูปแบบการเรยีนรู

แบบรวมมือเทคนิค  TGT  รายวิชา  คอมพิวเตอรมัลติมีเดีย 
 

2. ใสชื่อผูใชและรหัสผานในชองทีก่ําหนด 

 3.  คลิกตกลง  เพื่อเขาสูบทเรียน 

 4.  สําหรับนักเรียนทีย่ังไมไดลงทะเบียน  ใหคลิกปุมลงทะเบียน 
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ภาพ  6  แสดงหนาจอลงทะเบียนกอนใชงานระบบ 
 

 5.  เมื่อลงทะเบียนเรียบรอย  ใหเขาสูระบบอีกคร้ัง 

 
  

ภาพ  7  แสดงหนาจอสมาชิก  เมื่อเขาสูระบบ 
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6.  เมื่อเขาสูบทเรียน  ใหทาํการทดสอบกอนเรียน 

 7.  เมื่อทาํแบบทดสอบกอนเรียนเสร็จ  ใหเร่ิมเรียนจากหนวยที ่ 1 

 

 
 

ภาพ  8  แสดงหนาจอบทเรียน 
 

 8.  เมื่อนักเรียนเรียนจบแตละหนวย  ใหแยกกลุมตามที่แบงไวแลวชวยกันทํากิจกรรมทาย

หนวยการเรียนในหองสนทนาออนไลนตามคําชี้แจง  และสงงานผานเว็บบอรด  และ  e-mail  โดย

ใหหัวหนากลุมเปนตัวแทนสงงาน 

 9.  เมื่อนักเรียนสงงานเสร็จ  ใหสงตัวแทนกลุมแยกตามระดับความสามารถ  คือ  เกง  

ปานกลาง  และออน  เพื่อทําการแขงขันเกม  โดยนั่งตามโตะที่ครูกําหนดไวให 

 10.  เมื่อนักเรียนแขงขันเกมเสร็จ  ใหทําแบบทดสอบหลังเรียนประจําหนวยบนเว็บ 

 11.  เมื่อทําแบบทดสอบหลังเรียนประจําหนวยเสร็จ  ใหไปดูระดับความกาวหนาใน 

การเรียนของตนเองและของกลุม 

12. เมื่อนักเรียนเรียนเรียนจบทุกหนวย  ใหทําแบบทดสอบหลังเรียน 
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ภาคผนวก  ช 
 

ผลสัมฤทธ์ิทางการเรียนรายวิชาคอมพิวเตอรกราฟก 
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ตาราง  17  แสดงผลสมัฤทธิ์ทางการเรียนรายวชิาคอมพิวเตอรกราฟก  ภาคเรียนที่  1   
     ปการศึกษา  2553 
 

ผลสัมฤทธิ์ทางการเรียน 
ระดับชั้น 

4 3.5 3 2.5 2 1.5 1 0 
จํานวน
นักเรียน 

คาเฉลี่ย 

ม.4/1 

ม.4/2 

ม.4/3 

11 

3 

2 

5 

2 

3 

3 

7 

5 

13 

7 

3 

8 

6 

5 

1 

5 

8 

1 

4 

4 

0 

2 

10 

42 

36 

40 

2.89 

2.25 

1.68 

รวม 16 10 15 23 19 14 9 12 118 2.28 
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ประวัติผูศึกษาคนควา 
ชื่อ – สกลุ ศุภลักษณ    ขวัญแสน 
วัน  เดือน  ปเกิด 28  กรกฎาคม  2521 
ที่อยูปจจุบัน 232/2  หมู 2 ตําบลบานต้ิว  อําเภอหลมสัก  จงัหวัดเพชรบูรณ  

67110 
ที่ทํางานปจจบัุน โรงเรียนต้ิววทิยาคม ตําบลบานต้ิว  อําเภอหลมสัก  จงัหวัดเพชรบูรณ   
ตําแหนงหนาที่ปจจุบัน ครู อันดับ คศ.1 
ประสบการทาํงาน  

 พ.ศ. 2548 โรงเรียนหวยยางวิทยาคม  อําเภอคอนสาร  จงัหวัดชัยภูม ิ

 พ.ศ. 2551 โรงเรียนต้ิววทิยาคม ตําบลบานต้ิว  อําเภอหลมสัก  จงัหวัดเพชรบูรณ 

67110  
ประวัติการศกึษา  

 พ.ศ. 2554 กศ.ม.  (เทคโนโลยีและส่ือสารการศึกษา  แขนงคอมพวิเตอรศึกษา)  

มหาวิทยาลัยนเรศวร  จังหวดัพิษณุโลก 

 พ.ศ. 2545 ประกาศนยีบัตรวิชาชีพครู  วิทยาลัยพลศึกษา  อําเภอเมือง   

จังหวัดเพชรบรูณ 

 พ.ศ. 2544 วท.บ. (วิทยาการคอมพวิเตอร)  สถาบันราชภัฏนครสวรรค 

 
 


